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What's New

1 What's New

New features in ODBC Driver for Jira Service

Management 2.0
e Added support for the new extended API

¢ Improved compatibility with Node.js
¢ Improved compatibility with Tableau

¢ Improved compatibility with Vectorworks

New features in ODBC Driver for Jira Service
Management 1.2

¢ Fixed connection timeout setting before opening connection

¢ Now tokens and passwords are stored in an encrypted form in the DSN record

New features in ODBC Driver for Jira Service

Management 1.1
e Added support for SQL_ATTR_MAX_ROWS attribute

¢ Improved compatibility with Visual Basic in Visual Studio
¢ Improved compatibility with Linked Server in SQL Server

e Improved compatibility with Alteryx

New features in ODBC Driver for Jira Service
Management 1.0

e Initial release of ODBC Driver for ODBC Driver for Jira Service Management
e Windows 32-bit is supported
e Windows 64-bit is supported

2 General Information

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

ODBC Driver for Jira Service Management

2.1

1. Overview

2. Features

3. Compatibility
4. Requirements
5. Licensing

6. Getting Support

Overview

Overview

Devart ODBC Diriver for Jira Service Management is a high-performance connectivity security
with enterprise-level features for accessing Jira Service Management from ODBC-compliant
reporting, analytics, Bl, and ETL tools on both 32-bit and 64-bit Windows. Our ODBC driver
fully supports standard ODBC API functions and data types and enables easy and secure
access to live Jira Service Management data from anywhere.

« ODBC API M
+/ ODBC Data Types 1:,_
A1

Connection to Jira Service Management

Our data connector enables various ODBC-aware applications to connect to Jira Service

Management directly via HTTPS. If you have no direct access to Jira Service Management via
HTTPS, you have the option of establishing a connection through a proxy server.
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Application
HTTPS
ODBC Interface
Driver Manager Proxy ) )
Jira Service
Devart ODBC Driver Management

for Jira Service Management

2.2 Features

Connection to Jira Service

Management
Application
ODBC Interface HTTPS + L. . .
Our connectivity solution enables various
Driver Manager Proxy Jira Service . )
Devart ODBC Driver Management ODBC-aware applications to connect to

for Jira Service Management

Jira Service Management directly via
HTTPS. If you have no direct access to Jira
Service Management, you have the option
of establishing a connection through a

proxy server.
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4 ODBC Driver for Jira Service Management

Extended SQL Syntax

Our ODBC driver provides an unrivalled
opportunity to work with Jira Service
Management objects just as with SQL
tables. The extended SQL syntax allows
you to use all the SQL benefits in SQL-92
compatible SELECT statements:

* Complex JOINs

¢ WWHERE conditions

® Subqueries

* GROUP statements

® Aggregation functions
®* ORDER statements

® and more.

[« ]
=

+

G

DML Operations

Devart ODBC Driver for Jira Service

Management provides support for DML

Select P_Name,

P_Color,
Replace(P.OwnerName, ' ', '') As OName,
T.ResourceType,
T.Description,
W.EmailDomains,
W.IsOrganization

From Projects P

LEFT JOIN Teams T ON T.Id = P.TeamId

LEFT JOIM Workspaces W OM W.Id = P.Workspaceld

Where P.TeamMName = '"HAVI
And P.Followers = 500
Order By 2, 4
L
L I

=G
Bulk Updates

Moreover, with our driver you can perform

bulk updates to Jira Service Management
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(INSERT, UPDATE, DELETE) operations, by combining SQL statements into
which allows you to modify data in Jira batches, thus simplifying and speeding up
Service Management in the same way as |large data modification with Jira Service

in SQL databases. Management.

ODBC Conformance

The driver provides full support for common
ODBC interface:

* ODBC API Functions support g € \

==l AR
T

* ODBC Data Types support

In addition, we provide support for
Advanced Connection String parameters.
Thus allowing any desktop and web
applications to connect to Jira Service
Management from various environments

and platforms, that support ODBC.

Jira Service Management

Compatibility
. Jira Service Management
API
Jira Service Management ‘ )
Data Types Our ODBC driver fully supports all data

types defined in the Jira Service
Management API.
Moreover, the driver is compatible with the

Jira Service Management APl itself.
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6 ODBC Driver for Jira Service Management

Advanced Data Conversion |Mtegration

) The driver is compatible with 3rd-party data
We have implemented advanced Data

] ] ] . analysis tools, such as Microsoft Excel, and
Conversion mechanisms that provide bi-

o . ) integrates with various IDEs and systems
directional mapping between any Jira

_ like Visual Studio, etc.
Service Management and ODBC data

For a complete list of compatible tools and
types.

platforms, see Compatibility.

Platforms Variety Fully Unicode Driver

. ) ) With our fully Unicode driver, you can
Devart ODBC Diriver for Jira Service

_ ) retrieve and work with any data from muilti-
Management can be used with 32-bit and
64-bit applications on both x32 and x64

platforms, so there is no need to

lingual Jira Service Management
databases correctly, not depending on

. . whether its charset is Latin, Cyrillic,
additionally configure the driver,
o ] Hebrew, Chinese, etc., in any environment
applications or environment.
localization.

High Performance Support

Every operation with Jira Service o )

Visit our Support page to get instant help
Management becomes significantly faster .

from knowledgeable and experienced
using such capabilities of our driver as ) ) )

professionals, a quick resolution of your
Local data caching, connection pooling, . . .

problems, and nightly builds with hotfixes.
query optimization and much more.
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2.3 Compatibility

Jira Service Management Compatibility
Jira Service Management API v/
Jira Service Management Data Types v

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)

e Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion

Embarcadero Delphi & C++Builder
FileMaker

Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio

Omnis Studio

PHP

PowerBASIC

CIC SIS SIS LIS SIS

Python
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8 ODBC Driver for Jira Service Management

Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

SQL Server Reporting Services

CICOIC SO K

Bl & Analytics Software

Alteryx

DBxtra

Dundas Bl

FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle Bl

Power Bl

Qlik Sense

QlikView

CICIC SIS 1K S
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RStudio

SAP Crystal Reports
SAS JMP

Tableau

TARGIT

A N N N SN

TIBCO Spotffire

Office Software Suites

LibreOffice
Microsoft Access
Microsoft Excel

OpenOffice

AR N SRR NN

StarOffice

24 Requirements

The following requirements must be met for ODBC Driver for Jira Service Management:

¢ Only one version of ODBC Driver for Jira Service Management is installed on your system.

e NET Framework 4.5 or later is installed on your system.

2.5 Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
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10 ODBC Driver for Jira Service Management

TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
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General Information 1

the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.
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12 ODBC Driver for Jira Service Management

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
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accompanying written materials must be destroyed.
7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.

26 Getting Support

This document lists several ways you can find help with using ODBC Driver for Jira Service
Management describes the Priority Support program.

Support Options
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14 ODBC Driver for Jira Service Management

There are a number of resources for finding help on installing and using ODBC Driver for Jira
Service Management:

¢ You can find out more about ODBC Driver for Jira Service Management installation or

licensing by consulting Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for Jira Service Management
developers through the ODBC Driver for Jira Service Management Priority Support

program.

Subscriptions

The ODBC Diriver for Jira Service Management Subscription program is an annual

maintenance and support service for ODBC Driver for Jira Service Management users.

Users with a valid ODBC Driver for Jira Service Management Subscription get the following

benefits:

¢ Product support through the ODBC Driver for Jira Service Management Priority Support
program

e Access to new versions of ODBC Driver for Jira Service Management when they are

released
¢ Access to all ODBC Driver for Jira Service Management updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Diriver for Jira Service Management Priority Support is an advanced product support
service for getting expedited individual assistance with ODBC Driver for Jira Service
Management-related questions from the ODBC Driver for Jira Service Management
developers themselves. Priority Support is carried out over email and has a two business day
response policy. Priority Support is available for users with an active ODBC Driver for Jira
Service Management Subscription.

To get help through the ODBC Driver for Jira Service Management Priority Support program,
please send an email to support@devart.com describing the problem you are having. Make

sure to include the following information in your message:
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General Information 15

Your ODBC Driver for Jira Service Management Registration number.

e Full ODBC Driver for Jira Service Management edition name and version number. You can

find the version number in DLL version information.
¢ Versions of the Jira Service Management server and client you are using.
e A detailed problem description.

e |f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Jira Service Management.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com.

3 Using ODBC Driver

1. Installation

2. Connecting to Jira Service Management

3. Connection String Parameters

4. Enabling ODBC Tracing

5. Supported Data Types
6. Supported ODBC API Functions

3.1 Installation

ODBC Driver for Jira Service Management currently supports Windows 32-bit and 64-bit.

¢ Regular Installation

¢ Silent Installation

3.1.1 Windows

Installation on Windows

1. Download and run installer executive file.

2. Follow the instructions in the wizard.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
mailto:sales@devart.com
https://www.devart.com/odbc/jiraservice/download.html

16 ODBC Driver for Jira Service Management

1re Mana ¥ it [ hod

1 FEMICE Vianagement

Welcome to the Devart ODBC Driver for
Jira Service Management Setup Wizard

This will install Devart QDBC Driver for Jira Service
Management 1.0.0 on your computer.

It is recommendad that you close all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

WARNING: This program is protected by copyright law and
international treaties.

ODBC Driver

for Jira Service
Management

Mext = Cancel

3. If you already have the specified installation folder on the PC or another driver version is
installed, you will get a warning. Click Yes to overwrite the old files with the current
installation, but it is recommended to completely uninstall the previous driver version first,
and then install the new one.

4. On the Select Components page, you can choose whether to install the 64-bit version of
the driver. Clear the checkbox if you do not need a 64-bit installation. There is also a

checkbox on this page that allows you to choose whether to install Help and Manual.
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FE; SELUEY = LEVOlL UDS L = L 2ha 2K = Iiallalyic L=}

Select Components
Which components should be installed? devark

Select the components you want to install; clear the components you do not want to
install. Click Mext when you are ready to continue.

Full installation -
B Devart ODBC Driver for Jira Service Management 19,8 MB
B Driver for Win32 8,9 ME
B Oriver for Wingd 11,0 MB
B Help and Manual 2,4 MB

Current selection requires at lsast 24,2 MB of disk space.

= Back Mext = Cancel

5. On the License Information page, select when you want to activate the driver:
¢ Immediately after installation: Select Input Purchased or Trial activation key and
enter your key in the provided box, or click Load Activation Key and select the file
containing your key.

¢ Any other time: Select Activate product later.

You need to activate the driver even for the trial version.
You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.
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18 ODBC Driver for Jira Service Management

EEJ Setup - Devart ODBC Driver —

License Information

Enter yvour Purchased or Trial Key to activate the product. Getit on the
Customer Portal or load it from a file,

@ Input Purchased or Trial activation key

() Activate product later

U 1w FCODEMNGAEOF gbMzjuck JzV xGPY rkR Y SHB 7Tv

+th4+CRDPhEPZARMSEPY pPasaPTivaYeiQ 2bi TRigY yHAI FTTkhb dKEzWogdt oxsSUZ]
bzgVyAuSz2DgX FREMAhZ]D+HhPajyghTIEy Ez 7Due0QX tspppd SR IkS0uAILTIdOW
enAJQMzQGvDgF Sy /dz09B0Inrhg S9KEgficpgwTZIWE mmmTokvCkLICxSSom3Ei9gh
BqWcbDug/SlzakxSGEAWKSECSY 15gWYT +RIQF Y gALILIOtk 18N A=

Get Purchased or Trial Activation Key... Load Activation Key ...

6. Click Next to complete the installation.
7. Click Finish to exit Setup.

8. After the installation is completed, you need to configure the driver.

3.1.2 Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.
2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCJiraservice.exe /SILENT /ActivationKey=ylc7nmgdu2341aszxcvONGurjfh

DevartODBCJiraservice.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRt
Note: The installation is performed by entering a license key.

DevartODBCJiraservice.exe /SILENT /ActivationFile=d:\lic.key
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DevartODBCJiraservice.exe /VERYSILENT /ActivationFile=d:\1lic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

3.2 Remote Installation

One of the key advantages of Group Policy is the ability to deploy software remotely using MSI
files. This section explains how to use Group Policy to remotely install the ODBC Driver for
Jira Service Management on client computers.

The information is organized into the following sections:
e Creating the MST File Using Orca

e Remote Deployment and Activation

e Upgrading Driver Version and License Key

3.21 Package Transformation

Creating the MST File Using Orca

To customize the installation of the ODBC Driver for Jira Service Management, you first need
to edit the Windows Installer Package (MSI) by creating an MST file. This will allow for
customized installation of an original Windows Installer (MSI) Package.

An MST file, or Windows Installer Setup Transform file, contains program configuration
settings. In our case, the MST file for the ODBC Drriver for Jira Service Management will
include the correct license information. This MST file is used together with the original MSI
package in the Group Policy software distribution system.

There are many tools available for customizing MSl file settings, so you can choose the one
that best suits your needs. In this example, we'll be using Orca, which is available as part of
the Windows SDK Components for Windows Installer Developers. For more information
about Orca, visit the official Microsoft website.
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To start the process of MST file generation using the Orca editor, follow the steps below:

1. Launch the Orca application, then open the required MSl file by selecting Open in the File

menu or click the Open icon on the toolbar below.

€% Untitled - Orca — O X
File Edit Tables Transform Tools View Help
0O = e
Tables
&% Open X
Lookln:|, soft v| (I sl
~
I MName Date modified Type Size
ﬁlDevar‘tODBCSale;force 8/16/2024 410 PM  Windows Installer Package 80,5¢
Quick access
Desktop
m
Libraries
This PC
< >
i File name: | DevartODBC Salesforce ~ | | Open
Network
Files of type: Installer Database Files (*msi, “msm, *pcp, “msp) ~ Cancel
[ Open as read-only
Tables: 0 Mo table is selected. Mo column is selected.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the

ODBC Diriver for Jira Service Management.

2. As aresult, the Tables menu on the left side of the main application window will display the
properties of the selected MSl file.

3. Next, navigate Transform -> New Transform.
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&% DevartODBCSalesforce.msi - Orca

File Edit Tables
O =

Tables
AdminExecuteSeq
AdminUlSequence
AdvtExecuteSeque
AppSearch
Binary
CheckBox
Component
Condition
Control
ControlCondition
ControlEvent
CreateFolder
CustomAction

Transform  Tools  View

Mew Transform
Apply Transform...
View Patch...
Generate Transform...

Close Transform...

Transform Properties...

Help

21

4. To proceed, select Property from the Tables menu, then double-click any empty row on

the right side of the application window.

=4

File Edit Tables Transform Tools View Help

0 & =

Tables Property Value
AdminExecuteSequence UpgradeCode

AdminUlSequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Cemponent
Cendition

Centrol
CentrolCondition
CentrolEvent
CreateFolder
CustomAction
Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcon
InstallExecuteSequence
InstallU|Sequence
LaunchCondition
ListBox

Media
MsiFileHash
Property
RadioButton
Reqlocator
Registry
RemoveFile
Shortcut

Signature
TextStyle

UlTest

Upgrade
_Validation

WIXUICUSTOMEXITDIALOGOPTIONALCHECKBOX

WixlJIRMOption
WIXULINSTALLDIR
IsTrial

ALLUSERS
Productiame
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT

UseRM
INSTALLLOCATION
Trial

2

Devart ODBC Driver for Salesforce

App.ico

https://forums.devart.com,

{BE17A2F6-2B64-4ADF-A3EB-02DF 16208457}
1

/viewforum phpf=35
bt

WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY
MSIUSEREALADMINDETECT]
Manufacturer
ProductCode
ProductLanguage
ProductVersion
DefaultUlFont
WixUl_Mode

ErrorDialog

Infelcon

CRLF

TAB

SPACE
AdminProperties
SecureCustomProperties

httnef/ dewart
Add Row x
Name Value
?Pmperty ACTIVATIONKEY
Value
Column

Value - Localizable String[0], Required

'Q‘quanQiSkJOEWWSARIMBD/uquyﬂEvSTRCxFA4|

C Driver for Salesforce 3.4.1 on your computer. Click Mext to continue or Cancel to exit.

Haz}

TEXT
'WERFOUND; OLDESTFOUND;SELFFOUND;WIX_UPGRADE_DETECTED

In the Add Row dialog that opens, make the following settings and press OK to apply the

changes:

e Property - enter ACTIVATIONKEY with capital letters only.

e Value - enter the valid OEM license key for the ODBC Driver for Jira Service

Management.
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As shown in the following screen, a new property, ACTIVATIONKEY, has been added, with

the license key displayed in the value column next to it.

5. Once the configuration changes have been made, select Transform -> Generate

Transform.

2% DevartODB(CSalesforce.msi (transformed by Untitled) - Orca

File Edit Tables Transform Tools View Help

0O & t

Tables
AdminExecuteSeq
AdminliSequence
AdvtExecuteSeque
AppSearch
Binary
CheckBox
Compenent
Condition
Control
CentrelCondition
ControlEvent
CreateFolder
CustomAction
Dialog
Directory
EventMapping
Feature
FeatureComponents
File

lcen
InstallExecuteSequence
InstallUlSequence
LaunchCendition
ListBox

Media
MziFileHash

RadioButton
Reglocator
Reqistry
RemoveFile
Shertcut
Signature

and click Save to apply your settings.

New Transfol
Apply Transf
View Patch...

Generate Tra

m

orm...

"DIALOGOPTIONALCHECKBOX

nsform...

Close Transform

Transform Properties..

FrouUCUNanTIE
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT
WELCOME_TEXT

EXISTS

ISVALIDLICENSE
ARPNOMODIFY
MSIUSEREALADMINDETECTION
Manufacturer
PreductCede
Preductlanguage
PreductVersion
DefaultUIFont
WixUI_Mode

ErrorDialog

Infolcon

CRLF

TAB

SPACE

AdminProperties
SecureCustomProperties

Value
{BE17A2F6-2B64-4ADF-A3EB-82DF1620B457}
1
UseRM
INSTALLLOCATION
Trial

2

Devart ODBC Driver for Salesforce

App.ico
https://forums.devart.com/viewforum.php?=53
https://www.devart.com/odbc/

The Setup Wizard will install Devart ODBC Driver for Salesfarce 3.4.1 on your computer. Click Next to continue or Cancel to exit.
NO

0

1

1

Devart
{AEF4136F-3503-4328-9FD4-2883780CC432}
1033

341

WixlJl_Fent_Nermal

Mendo

ErrorDig

info

WIXUI_CUSTOMEXITDIALOGOPTIONALTEXT

RADE_DETECTED

[ ACTVATIONKEY

4t TPLYidEOt lfti

6. In the Save Transform As dialog that appears, enter a suitable name for the new MST file
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=
File Edit Tables Transform Tools View Help
D& RO LA
Tables Property Value
AdminExecuteSequence UpgradeCode {8E17A2FG-2B64-4ADF-A3EB-22DF1620B457}
AdminUlSequence WIXUI_CUSTOMEXITDIALOGO 2 Save Transform As %
AdvtExecuteSequence ‘WixUIRMOption
AppSearch WIXUI_INSTALLDIR .
Binary I<Trial Savein: | soft v @& e mr
CheckBox ALLUSERS -
Component ProductName % Name Date modified  Type Si
Condition ARPPRODUCTICON Na items match your search.
Contral ARPHELPLINK Quick access
ContrelCondition ARPURLINFOABOUT
ControlEvent WELCOME_TEXT - puter. Click Next to continue or Cancel to exit.
CreateFolder EXISTS
CustemAction ISVALIDLICENSE Desktop
Dizleg ARPNOMODIFY
Directory MSIUSEREALADMINDETECTIO| B
EventMapping Manufacturer n
Feature ProductCode Libraries
FeatureComponents PreductlLanquage )
File ProductVersion &
lcon DefaultUIFont =
InstallExecuteSequence Wixll_Mode This PC
InstallUlSequence ErrarDialog
LaunchCondition Infalcon S
ListBox CRLF L < >
Media TAB Network
Hash SPACE Fie name [Dsvat0DECSalestoree v [ e
i AdminProperties
RadioButton SecureCustomProperties Save as type: Windows Installer Transform (" mst) ~ Cancel GRADE_DETECTED
Reglocator (34K TPLYidECtItftil
Registry

RemanveFile

7. If successful, the encryption message DevartODBC Salesforce.msi (transformed by

DevartODBC Salesforce.mst) - Orca will be displayed at the top of the Orca application

window.

ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce.mst) - Orca — [} s
File Edit Tables Transform Tools View Help
b= % B
Tables ~ | Property Value ~
AdminExecuteSequence WixUIRMOption UszeRM
AdminUlSequence WIXULINSTALLDIR INSTALLLOCATION
AdvtExecuteSequence I=Trial Trial
AppSearch ALLUSERS 2
Binary ProductMName Devart ODBC Driver for Salesforce
CheckBox ARPPRODUCTICON App.ico
Component ARPHELPLIMEK https://forums.devart.com/viewforum.phpif=53
Condition ARPURLINFOABOUT https://www.devart.com/odbc/
Control WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.4.1 on you
ControlCondition EXISTS MO
ControlEvent ISVALIDLICENSE 0
CreateFolder ARPMNOMODIFY 1
CustomAction MSIUSEREALADMINDETECTION 1
Dialog Manufacturer Devart
Directory ProductCode {AEF4136F-3503-4528-9FD4-2885780CC432}
EventMapping Productlanguage 1033
Feature ProductVersion 341
FeatureComponents DefaultUIFont WixUl_Font_Mormal
File Wixl_Mode Mondo
lcon ErrorDialog ErrorDlg
InstallExecuteSequence Infolcon info
InstallUlSequence CRLF
LaunchCondition TAE
ListBox SPACE
Media AdminProperties WIXUILCUSTOMEXITDIALOGOPTIOMNALTEXT
MsiFileHash SecureCustormProperties ARPNOMODIFY: NETFRAMEWORKAS;NEWERFOUMND; OLDESTFOUMD; SELFF
Property | ACTIVATIONKEY ulw FabNzi 2Et1C CTlh+ LHrTrc1RLF:
RadicButton ¥
Realocator bl B >
Tables: 37 Property - 29 rows Mo celumn is selected.

In case of a positive outcome, the newly created MST file will be located in the folder you
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specified, alongside the MSl file.

3.2.2 Deployment and Activation

Installing and Activating Software Remotely

Group Policy automated-program installation is specifically designed for deploying Windows
Installer packages (MSl files). Therefore, when deploying the ODBC Driver for Jira Service
Management using Group Policy, be sure to use the corresponding MSI file for the ODBC
Driver for Jira Service Management.

Prerequisites: Locating the MSI Installation File

Prior to making configuration settings in the Group Policy, you'll need to create a distribution
folder:

1. Create a shared network folder on the publishing server.
2. Set the appropriate sharing permissions on this folder to allow read access to the driver
installation package for all domain users.

3. Download the ODBC Driver for Jira Service Management MSi file, and place it in the

network folder.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the

ODBC Driver for Jira Service Management.

Further in this section, you'll find more detailed information on how to deploy and activate the
ODBC Diriver for Jira Service Management on remote client computers using Group Policy.

Server-Side Actions
1. Open the Group Policy Management desktop application.

2. In the Group Policy Management window, navigate to the desired forest node, then
expand the appropriate option under the Domains node. For this example, we'll select

devart-test.test. Right-click the Domains node, and from the context menu, select Create
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a GPO in this domain, and Link it here.

ZL Group Policy Management — O *
3 File Action View Window Help - &
e nmalEBLE HE

5L Group Policy Management devart-test.test

v -é‘ FWESt: de.\fart-test.test Status  Linked Group Policy Objects Group Policy Inheritance  Delegation
v &5 Domains

3 devart-test.test - .
Vv [alRCEvarn et e : “'ve Directory and SYSVOL replication for this domain as it relates to Group Policy.

s/ Default Dot Create a GPO in this domain, and Link it here..,
=/ Devart ODE Link an Existing GPO...
= Windows L .
- R Block Inheritance
2 | Demain Cc
_f Group .Polin Group Policy Modeling Wizard... st test is the baseline domain controller for this domain. Chanage
- WMI Filters MNew Organizational Unit
)| Starter GPC . . .
& Sites Search in exists for this domain.
se¢ Group Policy Mod Change Domain Controller... w to gather infrastructure status from all of the domain cortrollers in this domain.

1| Group Policy Resu Remove

Active Directory Users and Computers...
View >

MNew Window from Here

Refresh
Help

Create a GPO in this domain a

3. You can now create a New Group Policy Object. In the New GPO dialog enter a name for
the new object and click OK. The new GPO will then appear within the Group Policy
Management container.

For example, let's create a GPO named after the ODBC driver name.

Mew GPO X

MName:
| Devart ODBC Driver|

Source Starter GPO:
{none) a

Keep in mind that each ODBC Driver for Jira Service Management Windows installation

package corresponds to one Group Policy Object (GPO), which is important for managing
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future software upgrades. To install multiple drivers using Group Policy, you need to create a

separate GPO for each driver you want to deploy.

4. Right-click the new object and select Edit from the context menu.

5L Group Policy Management - O >
5 File Action View Window Help - &
e | 2@ X6 HE
_'='£ Group Policy Management Devart ODBC Driver
M —i\ F?rest: de.\rart-test.test Scope Detalls Settings Delegation
v |55 Domains
2 Links
v 3 devart-test.test ] o )
s/ Default Domain Policy Display links in this location: devarttest test ~
,.j Devart ODBC Driver The followinn sites domains and O1ls are linked to this GPO:
s Windows Update Server Edit... )
:_ Domain Controllers Enforced h Enforced Link Enabled Path
v [ 5 Group Policy Objects . MNo Yes devarttest test
. +~  Link Enabled
= Default Demain Controllers Pc
=[ Default Domain Policy Save Report... R
- i
15} De.\rart ODBC Driver View 5
=] Windows Update Server )
E§ WM Filters Mew Window from Here sy to the following groups, users, and computers:
a Starter GPOs Delete
E éltes Policy Modeli Rename
sii Group Policy Modeling
4 Group Policy Results Eelie<h
Help we Properties
]
WMI Filtering

This GPO is linked to the following WMI filtter:

Open the GPO editor

5. In the left pane of the Group Policy Management Editor, navigate to Computer
Configuration --> Policies --> Software Settings --> Software installation. Your
current deployment package will appear in the right pane. Right-click Software

installation, then select New --> Package.
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= Group Policy Management —
p Policy : x
i FI|E A ok AVA ANl Li.l - g x
- $| E[ Group Policy Management Editor — O *
_sT File Action View Help
= Grou
vAres | aF|EGE HME
¥ '5| 5 Devart ODBC Driver Name . Version Deployment st.. Source
™ v i Computer Configuration
w || Policies >
~ [ Software Settings
Software installation
» [ Windows Settings MNew > Package... b
> [ | Administrative Templat )
= View ¥
» || Preferences o
v %, User Configuration Paste
’ __: ’ J Eoeljccies Refresh
d » || Preferences
[ = Export List...
Properties
Help
< IL
Adds a package.
|
WMI Filtering
This GPO is linked to the following WMI filter:
6. In the Group Policy Management Editor dialog that opens, select the desired MSI
installation file and click Open.
=l Group Policy Management — [} >
I ) 9
s Flle R L WA ATl Ll - =5
| 5] Group Policy Management Editor — O X
= $ Y g
il d e
|5 Grou &5/ Open x
v _ﬁ Ft
_5_ T « test-ad-del » soft v Search soft el
w
“ Organize » Mew folder = M @ oft\DevartODEC
[&] Pictures ~ Name Date modified Type
B Videos i3 DevartoDBC 8/19/20245:59PM  Windows Installer Pack
‘am Local Disk (C:)
|_ﬂ Metwork 5
_ﬁ LN 4 >
ﬁ-‘:l File name: |De\.rartODBC v| Windows Installer packages (*.r ~
< >
WMI Filtering

This GPO is linked to the following WM fitter:
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7. In the Deploy Software dialog, select Advanced to specify the software deployment

method. The Advanced deployment method allows you to make necessary modifications

to the MSl file, such as creating the MST file in Orca.

Deploy Software

Select deployment method:

Published

Select this option to configure the Published or Assigned options,
and to apply modffications to a package.

Cancel

8. In the Properties dialog of the installation package that opens, go to the Modifications tab

and select Add. Browse for the corresponding MST file, select it, and click Open to apply

the settings.

\&l Group Policy Management
2 File Action View Window Help
e @ X G|

54 Group Policy Management Devart OUBL HriverFroperties

|
Fi t: devart-test.test P
e i ?res SvartesLies General Deployment Upgrades Categores Modfications  Security
~ |55 Domains
w 335 devart-test.test Modffications or transforme allow you to customize the package and are
4 Default Domain Policy applied to the package in the order shown in the following list - O
sz Devart ODBC Driver
EEJ.’ Windows Update Server Move Up
= | Domain Controllers
= Group Policy Objects Move Down ion  Denlovment st. Source
& WMI Filters *
] Starter GPOs
& Sites P L « test-ad-decl » soft v O Search soft -l
s Group Policy Modeling
2 Group Policy Results Organize »  Mew folder - W @
&=/ Pictures L MName Date modified  Type
Removel [ Videos [ DevartODBC.mst 8/16/202440... MST File
s Local Disk (C)
Important! Do not press OK uf
comectly. For more informatiol
then dlick What's this? = Network
v £ >
(RN B0 evart ODBC . mist] v| Windows Installer transform pa
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9. If configured correctly, the Group Policy Management Editor window should look as

follows:

'=[ Group Policy Management Editor
File Action View Help
e HEEC= HE
- - =~
(5[ Devart ODBC Driver * || Mame Version Deploymen... Source
v (i Computer Configuration
w || Policies
~ [ | Software Settings
Software instal
| Windows Settings
| Administrative Ter
| Preferences

w 4 User Configuration w
< >

Devart ODBC Driver 3.4 Assigned Wtest-ad-dcT\soft\DevartODBC.msi

Client-Side Actions

For the ODBC Driver for Jira Service Management to be successfully installed on remote

client machines, all domain users must restart their computers after logging in for the first
time.

In case of successful deployment, the ODBC driver will be installed on the client's computer.

To verify, open the ODBC Data Source Administrator on the client's machine and add the
deployed ODBC driver.
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Create Mew Data Source

Select a driver for which you want to set up a data source.

MName Version

Devart ODBC Driver 3.04.01.00
S0L Server 10.00.15041.01
£

Col

De
Mir

< Back Cancel

All information on the deployed driver is accessible upon clicking the About tab.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver 31

Devart ODEC Driver Cenfiguration X

General Advanced Settings Security Settings  Tracng License About

Devart ODBC Driver
Desktop License

Version:

devart

5.3.0
Web:

www, devart, comfodbc

E-mail:

support@devart.com

ODBC Driver

© 2015-2025 Devart. All right reserved,

Test Connection . Cancel

Similarly, the valid license key will be automatically activated after the successful installation
of the ODBC Drriver for Jira Service Management.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About
License Information
Company:
Devart
User name:
ODBC Account
License number:
299E-2C8-001
Licensed for:
1 Desktop
Subscription for free updates expires on 12/31/2029
Get Purchased or Trial Activation Key...
Input Activation Key...
Deactivate Product
Test Connection o Ok Cancel
See Also
e Creating the MST File Using Orca
e Activating on Windows - ODBC Drriver for Jira Service Management
e License Information - ODBC Driver for Jira Service Management
3.23 Software Upgrade

Automatic Software Update Using Group Policy

If the ODBC Driver for Jira Service Management was initially deployed through Group Policy, it
can be easily updated to a newer version. Follow the steps below to update both the ODBC
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Driver for Jira Service Management and the license to newer versions on all remote
computers in the domain.

1. Download the ODBC Driver for Jira Service Management installation MSI file of a newer

version and place it in the shared network folder.

2. Create a new MST file with a new license key using Orca.

If your license is still valid, there's no need to create a new MST file. Use the current MST file

instead.
ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce_new_key.mst) - Orca — [m] *
Eile Edit Tables Transform Tools View Help
= #
Tables ~ | Property WYalue
AppSearch UpgradeCode {8E17A2F6-2B64-4ADF- ASEB-82DF 16208457}
Binary WIXUI_CUSTOMEXITDIALOGOPTIOMALCHECKBOX 1
CheckBox WixUIRMOption UseRM
Component WIXUI_INSTALLDIR INSTALLLOCATION
Cendition IsTrial Trial
Control ALLUSERS 2
ControlCondition ProductMame Devart ODBC Driver for Salesforce
ControlEvent ARPPRODUCTICON App.ico
CreateFolder ARPHELPLINK https://forums.devart.com/viewforum.php?f=33
CustomAction ARPURLINFOABOUT https://www.devart.com/odbc/
Dialeg WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.3.0 on your computer, Click Next to continue
Directory EXISTS MO
EventMapping ISVALIDLICEMSE ]
Feature ARPNOMODIFY 1
FeatureComponents MSIUSEREALADMIMDETECTION 1
File Manufacturer Devart
lcon ProductCode {73ABASBS-E56E-4828-BE3B-B6FDABSECS39)
InstallExecuteSequence ProductLanguage 1033
InstallUlSequence ProductVersion 3.5.0
LaunchCondition DefaultUIFont Wixl|_Font_Normal
ListBox WixUl_Mode Mondo
Media ErrorDialog ErrorDig
MsiFileHash Infolcon info
| Property CRLF
RadicButton TAB
Reglocator SPACE
Reqistry AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIOMALTEXT
RemoveFile SecureCustomProperties ARPMOMODIFY:NETFRAMEWORK45;NEWERFOUMD; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED
Shortcut ACTIVATIONKEY ulw7iCODENGAEDFabNziuflXuBv3wbzRIEH1 CADMCTIh+TVw/el HrTrc1RLFrwmdCSawbSwaRMiXara3 kDofi2d
Signature
TextStyle
UlText
Upgrade
_Validation v | < >
Tahles: 37 Pronerty - 79 rows. Mo column is selected

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the

ODBC Diriver for Jira Service Management.

3. Follow the same workflow as outlined in Step 4 to Step 7 of the ODBC Driver for Jira

Service Management Remote Deployment and Activation section.

4. In the Properties dialog that appears after selecting the Advanced deployment method,

go to the Upgrades tab and click Add.
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2) Properties ? it

F
H General Deployment Upgrades Categories Modffications  Security
[ |

Packages that this package will upgrade: Add Upgrade Package
Y Upgrade Devart ODBC Driver for Salesforce

Choose a package from
(®) Cumrent Group Policy Object (GPO)
() A specific GPO:

Browse...

Package to upgrade

Devart ODBC Driver for Salesforce (2)

Add... Remove

Required upgrade for existing packages

Packages in the cument GPO that will upgrade this package:

() Uninstall the existing package, then install the upgrade package
(®) Package can upgrade over the existing package

ok Conce

Make sure to select the following check boxes while adding the package:

e Current Group Policy Object
e Package can upgrade over the existing package

5. Browse for the corresponding GPO object and click OK to apply the settings.

BCSalesforce....
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Browse for a Group Policy Object

Domains/OUs  Sites Al

< |
|_'::>
g
[
1

Look in: |5 devart test test

All Group Paolicy Objects stored in this domain:

Mame

|=[ Defautt Domain Controllers Policy
\=[ Defautt Domain Policy

E Devart ODBC Driver for Salesforce
=] Windows Update Server

6. Now the Upgrades tab of the Properties dialog will list a new package with a newer

version.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

36 ODBC Driver for Jira Service Management

Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modffications  Security

Packages that this package will upgrade:

Upgrade Devart ODBC Driver for Salesforce

Upgrade Devart QDBC Driver for Salesforce (2]

Add... Bemove

Required upgrade for existing packages

Packages in the cumert GPO that will upgrade this package:

Corcs

7. Go to the Modifications tab in the same properties dialog, click Add and browse to the
MST file.

We have already created a new MST file with a new license key in Step 2.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modifications  Security

Maodffications or transforms allow you to customize the package and are
applied to the package in the order shown in the following list:

Modffications:

West-ad-de 1soft \DevatQDBC Salesforce_new keym Mave Up

Move Down

oo

Impaortart! Do not press OK until all transforms are added and ordered
comectly. For mare information, right-click on the Modfications list box, and
then click What's this?

Corcs

8. In case of a positive outcome both the old and new versions of the driver package will be

displayed in the Group Policy Management Editor.

= Group Policy Management Editor
File Action View Help

as Hm EQ HE

- Devart ODBC Driver for Salesfor|| Name Version Deploymentst.  Source
v i Computer Configuration Devart ODBC Driver for Salesforce 34 Assigned \\test-ad-dc\soft\DevartODBCSal...
v [ Polides Devart ODBC Driver for Salesforce (2) 35 Assigned \\test-ad-dc1\soft\DevartODBCSal..

v [ Software Settings
Software installat

| Windows Settings
| Administrative Templ

| Preferences

- n".; User Configuration
_ Policies
_ Preferences

Once the GPO configuration on the server is complete, the ODBC Driver for Jira Service
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3.3

3.31

Management will automatically update to the latest version each time a client computer
restarts.

Client-Side Actions

To update the ODBC Driver for Jira Service Management to a newer version on remote client
machines, all domain users must restart their computers after their first login.

If successful, both the driver and the license key will be automatically updated to the new
version on remote computers. For detailed instructions on how to view the technical details of
the ODBC Driver for Jira Service Management after upgrading, refer to Client-Side Actions.

See Also
e Creating the MST File Using Orca

e Remote Deployment and Activation - ODBC Driver for Microsoft Access

¢ Activating on Windows - ODBC Diriver for Jira Service Management

e License Information - ODBC Driver for Jira Service Management

Product Activation

See how to activate Devart ODBC Driver for Jira Service Management:

e Obtaining Activation Key

e Activation on Windows

e Where to see the license information

Obtaining Activation Key

Follow these steps to obtain your product activation key:

¢ From the Customer Portal:

1. Open the Customer Portal and sign in.

2. On the Product licenses page, select the driver.

3. Click Copy to clipboard to copy the activation key.
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Product licenses
g ODBC Driver Export license details
LicenselD Owner Assigned Type
> 375E-422F-001 email@example.com NOT ASSIGNED Single

Activation key:

nkLId7irC4nhZdUFN/6gbWxHYJhCHIyILz/195Nu90z Tp5cTIff 2pFg+LImLxlyGXPThgvA+D4jRhwwWBYXBEVZn
azsgkJiZwohsuG3+/Biy/MMHUNZhtrpM8lc3119Y wocKuaB4ANeGE7IC78ddalFfPumci+D280t829+16tnCSPwqV7
B8Q3GS1ZIoWYwWFIiJIiQvaN1cSYnep6553/3InHiF CaaKdfE46WdbqgQrimLNfHU+ZwvFDR3bTFKcEvgGgHITTCh
VAWDR4A4AXOIgBa==

Copy to clipboard

Assign this license to:

¢ From the registration email:
1. Locate the registration email you received from Devart after installing the driver. This
email contains a Purchased or Trial activation key.

2. Copy the activation key.

See also:

e Activation on Windows

3.3.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver, perform the following steps.
You need to activate the driver even for the trial version.
1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.
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'E- QODBC Data Source Administrator (84-bit)

lUser DSM System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Flatform  Driver 2 Add...
QDBC Driver for Azure_x32 32-bit Devart ODBC Driver for SQL 5

QDBC Driver for BigCommerce_x32 32-bit Devart ODBC Driver for BigCor Remove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynam

ODBC Driver for Firebird_x32 A2-bit Devart QDBC Driver for Firebirc Configure...

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Gd-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDE_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySQ1 ¥
£ >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Inthe Create New Data Source dialog, select the installed driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialog, navigate to the License tab, and click Input Activation Key.
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Devart ODEC Driver Cenfiguration X

General Advanced Settings  Security Settings  Tradng License  About

License Information

Mot registered

You may register ODEC Driver at
https: /fwww, devart, comfodbcf<driver=fordering. htmil

Get Purchased or Trial Activation Key...

Input Activation Key...

Test Connection . Ok Cancel

5. Here, you can activate the driver using one of the following methods:
e Enter an activation key: Paste your activation key into the corresponding box.
¢ Load an activation file: Click Load Key and select the file that contains the activation
key.
You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.
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Devart ODBC Driver Configuration

General Advanced Settings Security Settings  Tracing License  About

License Information

Mot registered

You may register ODBC Driver at
https: ffwww.devart, comfodbc/<driver=fordering. html

43

-

Input Activation Key

Activation Key

+RZQFYgALILIOH 18MA =|

U 1w FCODENGAEDFgbMzjuck IzVxGPY kR Y IHE TTv
+th4-+CROPh&PZARMS3pY pPasaPTivaeiQ 2bi 7Fig Y yHAI FITkhb /dkazwWog 4t oxSUZibzgVyAuSz 2DgX FREM
AJjhZj0+hPlajyghTIEy Ez TDxe0Q X tspppd SR Ik30uAIb fIdOWenAIQMNzQGivDgFSx fdz09B 0 Inrhg 59KEg fic
powTZIWa mmmTokyCkLICx5SomSEi9ghS8gWchDug/Slz8 kxS G AWKSGCHY 15gWYr

Load Key...

Get Purchased or Trial Activation Key...

Input Activation Key...

eactivate Product

Test Connection - (8.4

6. Click OK.

Where to See the License Information?

Cancel

To see the license information of your installed driver, do the following:

1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.
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'E- QODBC Data Source Administrator (84-bit)

lUser DSM System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Flatform  Driver 2 Add...
QDBC Driver for Azure_x32 32-bit Devart ODBC Driver for SQL 5

QDBC Driver for BigCommerce_x32 32-bit Devart ODBC Driver for BigCor Remove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynam

ODBC Driver for Firebird_x32 A2-bit Devart QDBC Driver for Firebirc Configure...

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Gd-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDE_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySQ1 ¥
£ >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Select the driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialogue, navigate to the License tab to view the license details.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About
License Information
Company:
Devart
User name:
ODBC Account
License number:
299E-2C8-001
Licensed for:
1 Desktop
Subscription for free updates expires on 12/31/2029
Get Purchased or Trial Activation Key...
Input Activation Key...
Deactivate Product
Test Connection Ok Cancel
3.4 Connecting to Jira Service Management

Connecting to Jira Service Management via OAuth

After installing the driver, create a DSN for Jira Service Management in the ODBC Data

Source Administrator.

1. Open the ODBC Data Source Administrator.

* Type oDBC Data Sources in the Windows search box and choose the application that

matches the bitness of the third-party application (32-bit or 64-bit). You can also open

ODBC Data Sources from Control Panel > Administrative Tools. Note that before
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Windows 8, the icon was named Data Sources (ODBC).
e Alternatively, you can run c:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe to create a 64-bit DSN.
2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.
3. Click Add. The Create New Data Source dialog will appear.
4. Select Devart ODBC Driver for Jira Service Management and click Finish. The driver
setup dialog will open.

5. Click the Sign in to Jira Service Management button.

| General  Advanced Settings License About

Data Source Mame Dewvart ODBC Driver for Jira Service Management

| Description

Refresh Token EEBEREERRE R RN RRRERR RN HSEVETDkEn

Cloud Name

| Cloud ID B - -

Sign in to JiraService

Proxy Server Part U]

Proxy User ID

Proxy Password []5ave Password

Test Connection . Cancel

6. Enter your credentials and log in.
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Continue to

< Jira

tnter your email

G Continue with Google
e Continue with Microsoft
4 Continue with Apple
-‘;" Continue with Slack

Can'tlog in? « Create an account

Privacy Policy + User Notice
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7. Provide the access for ODBC Driver for Jira Service Management to your Atlassian

account.

S — N°

Devart ODBC Driver is requesting access to
your Atlassian account.

< In Jira, it would like to:
Manage
> jira-project, jira-webhook, jira-configuration, jira-data-provider
View
> jira-user, jira-work
Update

> jira-work

Authorize for:

atlassian.net
Allow Devart to do this?
By clicking Accept, you agree to Devart's privacy policy and terms of use.

3 users have consented to using Devart ODBC Driver on their sites.

8. After accepting, if everything is successful, your details will be automatically populated into

the corresponding fields
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| General  Advanced Settings License About

Data Source Mame Dewvart ODBC Driver for Jira Service Management

| Description

Refresh Token EEBEREERRE R RN RRRERR RN ﬂSaVETDkEn

Cloud Name

| Cloud ID

Sign in to JiraService

Proxy Server Part U]

Proxy User ID

Proxy Password []5ave Password

Test Connection . Cancel

See Also

Connection Options

3.5 Connection String Parameters

Jira Service Management ODBC Connection String
Parameters

The following table lists the connection string parameters for ODBC Driver for Jira Service

Management.

Use the parameter to indicate the unique
Cloud ID

Cloud ID for your app.
Cloud Name Use the option to indicate the first part of your
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email you are using for login purposes, e.g.
from example@mail.com you should use

only example part

Use the parameter to indicate the refresh

token that authorizes the driver to access

Refresh Token
your ODBC Driver for Jira Service
Management data.
Proxy Settings
Proxy Server The proxy hostname or IP address.
Proxy User ID The proxy server account ID.
Proxy Password The proxy password.
The port number used to connect to a proxy
Proxy Port
server.
Advanced Settings
Allow NULL strings To retrieve metadata, not all parameters

according to MSDN can accept a null value. If

NULL, the driver should return an error. But
Empty strings as NULL some 3rd-party tools pass NULL to the

parameters. These options should be

enabled for compatibility with such tools.

The time (in seconds) to wait for a connection
Connection Timeout to open before terminating an attempt. The

default value is 60.

Used to set the behavior corresponding to
ODBC Behavior the ODBC specification version that a third-
party tool expects. The behavior of ODBC
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RegionalNumberSettings

RegionalDateTimeSettings

ReturnForeignKeys

driver can be changed by setting a value for
the SQL_ATTR_ODBC_VERSION attribute
by calling the SQLSetEnvAttr function. But
some third-party tools expect the driver to
exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the specified version or
pass an incorrect value there. In this case, the
required behavior can be explicitly specified
in the Connection String by setting the ODBC
Behavior parameter. The possible values
are:

*® Default - default ODBC behavior
determined by a third-party tool.

* Ver 2.x- ODBC 2.x behavior is explicitly
set.

* Ver 3.x- ODBC 3.x behavior is explicitly

set.

Enables the use of local regional settings
when converting numbers to strings.
Enables the use of local regional settings

when converting dates and times to strings.

Use the option to specify whether the driver
must return foreign keys. Retrieving metadata
about foreign key constraints is a time-
consuming operation; many third-party tools
request foreign key metadata even whey they
do not actually need this information. Note

that enabling the option may degrade
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String Types

QueryTimeout

UTC Dates

performance of data access operations. The
default value is False.
Sets the string value types returned by the

driver as Default, Ansi or Unicode.

® Default - the driver defines the string types.

® Ansi - all string types will be returned as
SQL_CHAR, SQL_VARCHAR and
SQL_LONGVARCHAR.

® Unicode - all string types will be returned as
SQL_WCHAR, SQL_WVARCHAR and
SQL_WLONGVARCHAR.

The parameter value should be changed if
any third-party tool supports only Ansi string

types or Unicode ones.

The time to wait for a query execution result
before terminating and generating an error.
Specifies whether all the datetime values
retrieved from the data source are returned
as UTC values or converted to local time and
whether the date values specified on the
application side (e.g., in SQL statements)
are considered UTC or local. The default

value is false.

ODBC Driver for Jira Service Management Connection String sample

DRIVER={Devart ODBC Driver for ODBC Driver for Jira Service
Management};Refresh Token=yourrefereshtoken;Cloud
Name=yourcloudname;Cloud ID=yourcloudid
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3.6 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test connection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 0o N O O

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.
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Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:
[oDBC(C]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

3.7 Usage Statistics

Usage Statistics

ODBC Diriver for Jira Service Management can collect anonymous usage statistics. This data
helps us improve product quality, resolve issues faster, and better understand how our
products are used.

The collected data is anonymous and does not include personal information. The amount of
transmitted data is minimal and is used only for diagnostic and product improvement
purposes.

Collected Data

The driver collects the following data:

¢ Product name and version.

e Name of the process (application) using the driver.

e License information: license type, license number, and license status.
e Operating system name and version, number of processor cores.

e An anonymous user identifier.

The user identifier is an internal ID generated only for statistical purposes. It is not the

operating system user name and cannot be used to identify the actual user.
e An anonymous hardware identifier.

The hardware identifier is an internal ID generated only for statistical purposes. It does not
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contain any data that can identify specific hardware.

e Database server name and version.

e Names of connection parameters used to connect to the database server.

Only parameter names are collected. We do not collect parameter values such as database

name, user name, or password.
e Connection result: success, or a numeric error code if the connection fails.

Only the numeric error codes are collected. We do not collect full error messages, which

might contain sensitive data (for example, database or user names).

Default Settings

Usage statistics is enabled by default when you install the driver.

To disable usage statistics, follow the instructions for your operating system:

e Enable or Disable Usage Statistics on Windows

Enable or Disable on Windows

Enable or Disable Usage Statistics on Windows

Usage statistics is enabled by default when you install the driver. You can disable it in one of
the following ways:

¢ During installation: In the installation wizard or from the command line.

¢ After installation: By editing the Windows Registry.

Disable Usage Statistics in the Installation Wizard

To disable usage statistics in the installation wizard, clear the Improvement Program

checkbox on the last page of the wizard. The checkbox is selected by default.
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ﬁ_."?'.-! Setup - Devart ODBC Driver —

Completing the Devart ODBC Driver Setup
Wizard

Setup has finished installing Devart ODBC Driver on your
computer.

[ Improvement Program™

ODBC Driver

Hedg 8 improve our products and §ix B Tasber by sharing a Emiled s of
ancynies data, inchuding Tunclionalily wsage slatstics, dagnostic nfomation, and
pesTarmance data,

Disable Usage Statistics From the Command Line

When you install the driver from the command line, you can disable usage statistics by
adding the /NousAGESTATISTICS parameter to the command.

Silent and Very Silent Mode

To disable statistics during silent or very silent installation with the EXE installer, run one of
the following commands:

DevartODBCJiraservice.exe /NOUSAGESTATISTICS /SILENT
DevartODBCJiraservice.exe /NOUSAGESTATISTICS /VERYSILENT

Quiet Mode

To disable statistics during quiet installation with the MSl installer, run the following command
as an administrator:

msiexec /i DevartODBCJiraservice.msi /g NOUSAGESTATISTICS=true

Change Usage Statistics Settings in the Windows Registry

To enable or disable usage statistics for an installed driver, edit the Windows Registry as
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follows:
1. Open the Registry Editor. To do this, press Win+R, type regedit in the Run dialog, and
press Enter.

2. Depending on your driver version, navigate to one of the following keys:

e 64-bit driver: HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI\Devart ODBC Driver for

Jira Service Management

e 32-bit driver: HKEY_LOCAL_MACHINE\SOF TWARE\WOW6432Node\ODBC\ODBCINST.INI\Devart ODBC

Driver for Jira Service Management

3. Set the value of the usagestatistics parameter to False to disable statistics, or True to

enable statistics.

3.8 Supported Data Types

Data Type Mapping

The Devart ODBC Driver for Jira Service Management supports all Jira Service Management
data types.

The following table describes how the Jira Service Management data types are mapped to the

ODBC data types.

JiraService Data Types ODBC Data Types
ANYTYPE SQL_WVARCHAR
AUTONUMBER SQL_WVARCHAR
BINARY SQL_LONGVARBINARY
CHECKBOX SQL_BIT

COMBOBOX SQL_WVARCHAR
DATACATEGORYGROUPREFERENCE |SQL_VARCHAR

EMAIL SQL_WVARCHAR
ENCRYPTEDTEXT SQL_WVARCHAR
HTML SQL_WLONGVARCHAR
ID SQL_WVARCHAR
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INT SQL_INTEGER
LONGTEXTAREA SQL_WLONGVARCHAR
MULTISELECTPICKLIST SQL_WVARCHAR
NUMBER SQL_DOUBLE

PHONE SQL_WVARCHAR
PICKLIST SQL_WVARCHAR
REFERENCE SQL_WVARCHAR
TEXTAREA SQL_WVARCHAR

TIME SQL_TYPE_TIME

URL SQL_WVARCHAR

3.9 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Jira Service Management supports all deprecated functions for backward

compatibility.
The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle v ISO 92 connection,
statement, or
descriptor handle.
Connects to a

SQLConnect v ISO 92
specific driver by
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data source name,
user ID, and
password.
Connects to a
specific driver by
connection string or
SQLDriverConnect y ODBC "equests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
SQLAllocEnv v Deprecated environment handle
allocated from driver.

Obtains a
SQLAllocConnect v Deprecated
connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose
Returns the list of

available data
SQLDataSources v ISO 92

sources, handled by

the Driver Manager

Returns the list of

installed drivers and
SQLDrivers v ODBC their attributes,

handles by Driver

Manager
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SQLGetInfo

SQLGetFunctions

SQLGetTypelnfo

ISO 92

ISO 92

ISO 92

Returns information
about a specific
driver and data
source.

Returns the functions
supported by the
driver.

Returns information
about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes

Function Name

SQLSetConnectAttr

SQLGetConnectAttr

SQLSetConnectOpti

on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvALttr

SQLSetStmtAttr

v

Standard
ISO 92

ISO 92

Deprecated

Deprecated

ISO 92

ISO 92

ISO 92

Purpose
Sets a connection

attribute.

Returns the value of
a connection
attribute.

Sets a connection
option

Returns the value of
a connection option
Sets an environment
attribute.

Returns the value of
an environment

attribute.

Sets a statement
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SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

ISO 92

Deprecated

Deprecated

attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

SQLBindParameter

SQLGetCursorNam

e
SQLSetCursorNam
e

SQLSetScrollOption

S

ODBC API Calls for Submitting Requests

Standard

Deprecated

ISO 92

ODBC

ISO 92

ISO 92

ODBC

Purpose
Allocates a

statement handle

Prepares an SQL
statement for later

execution.

Assigns storage for
a parameterinan
SQL statement.

Returns the cursor
name associated
with a statement
handle.

Specifies a cursor
name.

Sets options that
control cursor

behavior.
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Function Name Support Standard Purpose

Executes a prepared
SQLExecute v ISO 92

statement.

_ Executes a
SQLExecDirect v ISO 92

statement

Returns the text of an
_ SQL statement as
SQLNativeSq| v ODBC
translated by the
driver.
Returns the
) description for a
SQLDescribeParam v ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v ISO 92 of parameters ina
statement.

Used in conjunction

with SQLPutData to

supply parameter
SQLParamData v, ISO 92 PPYP

data at execution

time. (Useful for long

data values.)

Sends partor all of a

data value for a
SQLPutData v ISO 92

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

64 ODBC Driver for Jira Service Management

Function Name Support Standard Purpose
Returns the number

of rows affected by
SQLRowCount v, ISO 92

aninsert, update, or

delete request.

Returns the number
SQLNumResultCols v ISO 92 of columns in the

result set.

Describes a column

SQLDescribeCol v, ISO 92
in the result set.

Describes attributes
SQLColAttribute v ISO 92 of a columnin the

result set.

Describes attributes
SQLColAttributes v Deprecated of a columnin the

result set.

Returns multiple
SQLFetch v ISO 92

result rows.
Returns scrollable

SQLFetchScroll W, ISO 92 I
result rows.

Returns scrollable
SQLExtendedFetch v Deprecated

result rows.

Positions a cursor
within a fetched
block of data and
SQLSetPos v ODBC enables an
application to refresh
data in the rowset or

to update or delete
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SQLBulkOperations v ODBC

data in the result set.
Performs bulk
insertions and bulk
bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information

Function Name Support Standard
SQLError v Deprecated
SQLGetDiagField v ISO 92
SQLGetDiagRec v ISO 92

Purpose
Returns additional

error or status

information

Returns additional
diagnostic
information (a single
field of the
diagnostic data

structure).

Returns additional
diagnostic
information (multiple
fields of the
diagnostic data

structure).

ODBC API Calls for Obtaining Information About

Database Objects (Catalog Functions)
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Function Name Support Standard Purpose
Returns a list of

o columns and
SQLColumnPrivileg

es

-/ ODBC associated
privileges for one or
more tables.
Returns the list of

SQLColumns v X/Open column names in
specified tables.
Returns a list of
column names that

SQLForeignKeys v ODBC make up foreign
keys, if they exist for
a specified table.
Returns the list of

SQLPrimaryKeys v ODBC column names .that
make up the primary
key for a table.
Returns the list of
input and output

parameters, as well
SQLProcedureColu

mns

v, ODBC as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
procedure names

SQLProcedures v ODBC
stored in a specific

data source.
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SQLSpecialColumn

S

SQL Statistics

SQLTablePrivileges

SQLTables

X/Open

ISO 92

ODBC

X/Open

Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
table, or the columns
that are
automatically
updated when any
value inthe row is
updated by a
transaction.
Returns statistics
about a single table
and the list of
indexes associated
with the table.
Returns a list of
tables and the
privileges
associated with
each table.

Returns the list of
table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name

Standard

Purpose
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SQLTransact v Deprecated

SQLEndTran v ISO 92

Commits or rolls
back a transaction
Commits or rolls

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard
SQLFreeStmt v ISO 92
SQLCloseCursor v, ISO 92
SQLCancel v ISO 92

Purpose
Ends statement

processing, discards
pending results, and,
optionally, frees all
resources
associated with the
statement handle.
Closes a cursor that
has been opened on
a statement handle.
Cancels an SQL

statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard
SQLDisconnect v ISO 92
SQLFreeHandle v ISO 92

Purpose
Closes the

connection.
Releases an
environment,
connection,
statement, or

descriptor handle.
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Releases connection
SQLFreeConnect v Deprecated han
andle.
Releases an

SQLFreeEnv v Deprecated
environment handle.

4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Jira Service Management with ODBC-
compliant tools.

e DBeaver
e DBxtra

¢ |nformatica PowerCenter

e Microsoft Access

e Microsoft Excel

¢ Microsoft Visual Studio

e OpenOffice and LibreOffice

e Oracle Database Link

* PHP
e Power Bl
* Python

e QlikView

e SQL Server Management Studio

e SSIS

e Tableau

41 Using in DBeaver

This section describes how to connect DBeaver to Jira Service Management using Devart
ODBC Diriver for Jira Service Management.
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411

e Connect DBeaver Community to Jira Service Management through ODBC

e Connect DBeaver Enterprise to Jira Service Management through ODBC

Connect DBeaver Community to Jira Service Management through ODBC

DBeaver Community and DBeaver Enterprise let users connect to Jira Service Management
via ODBC, enabling SQL-based querying, reporting, and data management.

If you need basic ODBC connectivity to Jira Service Management and are comfortable with
manual configuration using a generic ODBC Connection, choose DBeaver Community—a
free, open-source database management tool.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise. For more information on
connecting to Jira Service Management data from DBeaver Enterprise, see Connect DBeaver

Enterprise to Jira Service Management through ODBC.

Initial configuration

1. Download jdbc-odbc-bridge-jre7.jar and x64/3dbcodbc.d11 from Github.

2. Download the Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package

from the Microsoft website.

The built-in legacy ODBC driver was removed in DBeaver Community Edition 23.1. If you're
using an earlier version of DBeaver Community, skip steps 1 and 2.

3. Configure an ODBC data source. For more information, see Connecting to Jira Service
Management.

4. On the Advanced Settings tab of the DSN configuration window, select Ansi from the
String Types.

This option is required for the proper display of the SQL_WVARCAHAR data type in DBeaver.
It also ensures that all string types will be returned as SQL_CHAR, SQL_VARCHAR, and
SQL_LONGVARCHAR.
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Devart ODEC Driver Configuration X

General Advanced Settings Tradng License About

Metadata
B Empty Strings as NULL B allow NULL Strings

[ ] Return Foreign Keys {may significantly degrade performance)

Cache Metadata 1Day o
Connection

Connection Timeout &0 [CJuTC Dates
Query Timeout &0 [} indude Deleted

Use Local Regional Settings when converting to string

[ Mumbers [ Dates and Times
Compatibility

ODEC Behavior Default b4

String Types | Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LON( ~

Test Connection . Cancel

Connect to Jira Service Management

1. In DBeaver, select Database > Driver Manager.

2. Click New.
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=% Driver Manager

Type part of database/driver name to filter

Mame

W sOlite
1 Altibase
@ Apache Calcite Avatica
& Apache Ignite
# Apache Kylin
> B3 AWS
s S Azure
& Arure Databricks
Q Babelfish via TDS (beta)
[| Cache
= (Cassandra
ClickHouse
ClickHouse (Legacy)
A2 Clandherne

Generic provider

3. Configure the following properties for a new driver:

¢ |n the Driver Name field, enter ODBC.

¢ |In the Class Name field, enter sun.jdbc.odbc.JdbcOdbcDriver
¢ In the URL Template field, select jdbc:odbc:{database}.

Copy

Edit ...
Delete
Un-delete

T - User defined

& - Unavailable

Close
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@ Create new driver

Settings | Libraries | Default properties | Advanced parameters

Driver Name:  ODBC Driver Type: | = Generic v

Class Mame: sun,jdbc.odbe)dbcQdbeDriver

URL Template: jdbciodbo{database}
Default Port:

Default Database:

Default User:

[[JErmbedded [] Propagate driver properties [_] No authentication [_JiAllow Empty Password:
[[] Use legacy JDBC instantiation [ Thread safe driver

Description

1D 55052241-1D12-5734-4177-5C2F49673070

Description:

Reset to Defaults Cancel

4. On the Libraries tab, click Add File.

5. Select the jdbc-odbc-bridge-jre7.jar, then click OK. After that, select 3dbcodbc.d11, then
click OK.
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‘&! Create new driver

O X
Settings | Libraries | Default properties | Advanced parameters
s Ci\Users) \Downloads\download_files\jdbc-odbc-bridge-jre? jar hdd File
En C\Usersy \Downloadshdownload_files\JdbcOdbe.dll s
Add Folder
Add Artifact
Edit ...
Delete
Download/Update
Information
Classpath
Driver class: ~ | Find Class Export
Reset to Defaults oK

Cancel
[

6. Once a new ODBC driver appears on the list, click Close.
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=% Driver Manager O >

Type part of database/driver name to filter

Mame # Copy

MDB Cluster

® Neodj Edit ..

M Metezza Delete
MucDB -

c8 OceanBase Un-delete

O Ocient

E ODBC T - User defined

= ODBC - Legacy B - Unavailable

E] Omnisci (formerly MapD)
:.) Open Distro Elasticsearch
8. OpenEdge

h_-"j OpenSearch

E Cracle

MirientE

Close [:?

7. Select Database > New Database Connection.
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'g! DBeaver 24.3.5
File Edit Mavigate Search 50LEditor Database Window Help

¢ - [JsaL - ¥, MNew Database Connection
= MNewC ction from JDBC URL
f® Database Navigator [ Projects = s -ennection frem
= Driver Manager
Enter a part of object name here
Disconnect All
£74 Open Dashboard
¥ Tools
Context tools
& Tasks

8. Select the ODBC driver, then click Next.

= O x
Ctrl+Shift+ M | s
=5
Ctrl+ Alt+5Shift+ B
>
Alt+"
* T|en
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| ) Connect to a database O >

Select your database

Create new database connection. Find your database driver in the list below.

Type part of database/driver name to filter ¥ | Sortby: O Title €@ Score
|
2 Al ¥y d ™ |
Ty crn® ORACLE
& Popular MariaDB MySQl
EN SOL
D2 for LUW MaraDB MySOL Oracle
B NoSQL
EN Analytical
EN Timeseries :‘;_;.‘23 AlTisase
N Embedded ﬁ‘ﬁﬂkﬁ,e
rver
“F Hadoop / BigData ! ~
PostgreS0L SOL Server S0Line Alibaze Apache Calcite
Auatica
-
Test Connection ... < Back Mesxt = Finish Cancel

9. In the Database/Schema field, specify the name of your DSN.
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@ Connect to a database (|

Generic JDBC Connection Settings
ODBC connection settings

Main | Driver properties | 55H -+ Network configurations...

General
Connect by: © Host (JURL

Jjdbc:odbo:DEEAVER_DATASOURCE
Database/Schema: DBEAVER_DATASOURCE

Authentication (Database Mative)

Username:

Password: B Save password
(1) Connection variables information Connection details (name, type, ... )
Driver name: ODBC Driver Settings
Test Connection ... < Back Mest Cancel

10. Optional: Select Test Connection to verify the connection settings.

E Connection test O x
(D Connected (141 ms)
Server:
Driver: JDBC-ODBC Bridge (DevartODBC il 2.0001
(03.04.0200)

Details ==

11. Click Finish.

The database appears on the left pane.

12. To view the data stored in a table, expand the database structure and click the needed
table.
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(%) DBeaver 24.3.5 - Account = a X
Eile Edit Mavigate Search 50OLEditor Database Window Help
[ v| % & W | [Osar =:i[} Commit [ Rollback T v & Auto |49 v DBEAVER DATASOURCE ~ [ <N/A> v @y~ fh viQ v
Q iE|®
f® Database Mavigator 3 [ Projects = O FBAccount X S5 DBEAVER_DATASOURCE B8 Solution = 0
=% FF Properties | ) Data ﬁg-n ER Diagram|
Enter a part of object name here T - . —
v =, DEEAVER DATASOURCE BB Account | 23 Entera S400 SO ERr RS (G5E S SAaeE rIv|[ErTrero -
~ [ Tables | [z o) . .V‘AZV|A!HamE V|A-ZV|A-ZV|AZV|AZV|AZV| [ Value X i |
o
’ ;ic(eptetdEventRelat\on Hl 118 001240( L] Kate West (Sample) Custorr [MULL Kings P L B E; E “:,_'U
? ceoun 119 | 0012400 [ ] ,,: Kate West (Sample) Custorr [MNULL 9 Tagor Singape Smgap: 0D108000020EKXLA & | &
5 9 AccountChangebvent b1 E AD
5 B AccountCleaninfo — 120 oo2400 [ ] LL] Kate West (Sample) Custorr [MULL 312 Cor Austin TX gg
5 FM AccountContactRole [_3' 121 oo2400 [ ] LL] Kate West (Sample) Custorr [MULL 5255, L Burling NC ®
5 [ AccountContactRoleChangeEvent 122 | 0012400 [ ] LL] Kate West (Sample) Custorr [NULL 2Place Paris IULL i
5 [ AccountFeed = 123 o02400 [ 1 LL] Kate West (Sample) Custorr [MULL 1301 He Lawren KS N
» B AccountHistory § 124 | 0072400 [ ] LL] Kate West (Sample) Custorr [MULL 2334 N. Chicag IL B
5 B AccountPartner E 125 | 0012400 [ ] LL] Kate West (Sample) Custorr [NULL 620 SW Portlan OR
» B8 AccountShare 126 oo2400 [ ] LL] Kate West (Sample) Custorr [NULL 888 NE Tucson AZ
» B8 ActionLinkGroupTemplate 127 0012400 [ ] LL] Kate West (Sample) Custorr [MULLT 1307 Av New Yc NY
» A ActionLinkTemnplate 128 | 0012400 [ ] LL] Kate West (Sample) IULL] [WULL The Lar San Fra CA
» A ActiveFeatureLicenseMetric 129 0011p0l [ ] LL] Kate West (Sample) IULL] [MULL, [NULL] LL IULL
» A ActivePermSetLicenseMetric 120 nninant 11 1 Kate Weet (Samnlel 1 1
5 A ActiveProfileMetric bt
5 E2 ActivityFieldHistory @ Refresh + i (DSave » [ Cancel 15 I3 5 = 1€ € > Dl T X Exportdata ~ | €8
5 P ActivitvHistory - =
200 Z 200+ : () 200 row(s) fetched - 0.653s (0.061s fetch), on 2025-02-19 at 17:20:16 - 5 waming(s) l‘_‘\
S, DBEAVER_DATASOURCE » FF Account Table: Announcement | E€T | en
1. Select SQL Editor > New SQL script.
(&) DBeaver 24,35 - Solution - ] X
File Edit Mavigate Search 50L Editor Database Window Help
¥ -‘ Ve q| [Jsc [J OpensaLscript F2
Last edited SQL script Ctrl+Enter
DBEAVER_DATASOURCE = [ s _ Q E|@
[ New SOL script Ctrl+]
= : =
f% Database Navigator X [ Open SCOL console Ctrl+Alt+Enter =
. Panels >
Enter a part of object name here
Layout ¥ b v 2T~

5 B8 Seclution

s+ [ SolutionFeed Context 3 ¥ | Az Solutiont [y x| = x|
» FA SelutionHistory =) E” >
» FH SelutionStatus Auto-sync connection with navigator 00000002 50124900';] - “3;_
» E5 Stamp Open separate connection > 00000003 OcvwCzAA| S5
» FH StampAssignment . LL
» B StaticResource - i bl [] @
> [ StreamingChannel 5 50124000000cvD3IAAI [] 00000005 m
» B3 StreamingChannelShare ] 30124000000cvDAAAI [] 00000006 .
s+ [ TabDefinition }’, i 50124000000cvD5AAI [1] 00000007 e
> E TabledVerify_c E E
» o TabledVerify__ChangeEvent I ] @ Refresh ~ i () Save + [ Cancel { 5 53 I@ ==
» 3 TableauHostMapping _ )
» [ TableauHostMappingShare HE € > M b d, Exportdata ~ g 200 X 0
« A Tack

10 row(s) fetched - 0.241s (0.003s fetch), on 2025-02-24 at 16:15:48 [

=% » B2 Solution  Table: TaskPriority | EI-_—I'| en
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2. Enter your query.

() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search SOLEditor Database Window Help
€ v| & | [Jsar ~:[ T @ Auto |49 v DBEAVER DATASOURCE ~ [ <N/A> ~ iy~ &b viQ ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
= & E [ 3 SELECT SolutionName, SolutionNote FROM Solution;|
Enter a part of object name here ¥ - ».
> B8 Site o]
> B8 SiteDetail -
» A SiteFeed -
» P SiteHistory
» A SitelframeWWhiteListUrl
> FH SiteRedirectMapping
» E2 Solution
5 A SolutionFeed
» F2 SelutionHistory
» A SolutionStatus
» B8 Stamp
» FH StampAssignment
» A StaticResource e ]
> FH StreamingChannel
» F2 StreamingChannelShare
B
» F2 TabDefinition I
» B8 TabledVerify_c I}
> FX TabledVerify_ ChangeEvent =
3 A TableauHostMapping HE
EET | en | Writable Smart Insert 1.8
3. Select SQL Editor > Execute SQL query.
The query results are displayed in the main window.
() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search 50l Editor Database Window Help
€ v| & | [Jsar ~:[ T @ Auto |49 v DBEAVER DATASOURCE ~ [ <N/A> ~ iy~ &b viQ ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
=+ 8 » SELECT SolutionName, SolutionNote FROM Solution;|
Enter a part of object name here ¥ - ».
> B8 Site 3
> B8 SiteDetail "B Solution1 X |
» A SiteFeed
s 3 SiteHistory T SELECT SolutionMame, Solu | § 5 b v | 2T~ - -
» FA SitelframeWhiteListUrl =] | 27 SolutionMame * A7 SolutionMNote hd  Value X = ;q
SiteRedirectM had 2
z ; Sloleu‘tleo:e wdld, Ha GC1020 Portable Generator Switch Mal‘fud If the generator switch is not working, rerr [ U =] =0 “3_’0
. & Generator assembly instructions unclear  The Maintenance Manuals for the GC1020 GC1020 Portable | & | &
5 A SolutionFeed g
s E3 SolutionHistory - 3 Maintenance guidelines for generator unc The Maintenance Manuals for the GC1060 -
» [ SolutionStatus E 4 Selecting the Right Generator for Your Nee GenWatt offers a wide range of electric ge @)
» [ Stamp 5 GC3000 Series Propane Generator Ignition The GC3000 series propane generators nee A
> FE StampAssignment & Starting generator after electrical failure  After an electical failure, the generator has .
> FF StaticResource 7 Electrical wiring installation for GC5060  The red wiring from the top electronic par iz
> FH StreamingChannel '?5 8 GenWatt SLA Commitments GenWatt offers four different SLAs with dil "
» F2 StreamingChannelShare i 9 Electronic panel fitting loose On the GC3020, the electronic panel is knc
» FH TabDefinition | g 10 GenWatt Installation Services GenWatt Corporation has a full-service su|
» F3 TabledVerify_c -
> B8 TabledVerify_ChangeEvent @ Refresh - SR m =il < oo : 1 Exportdata ~ 3
> FA TableauHostMapping
200 XY o10: 10 row(s) fetched - 0.378<, on 2025-02-19 at 18:34:18 [ Ja}
EET | en | Writable Smart Insert 1.8
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41.2

Connect DBeaver Enterprise to Jira Service Management through ODBC

DBeaver Enterprise and DBeaver Community let users connect to Jira Service Management
via ODBC, enabling SQL-based querying, reporting, and data management.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise.

If you need basic ODBC connectivity to Jira Service Management and are comfortable with
manual configuration using a generic ODBC connection, choose DBeaver Community—a
free, open-source database management tool. For more information on connecting to Jira
Service Management data from DBeaver Community, see Connect DBeaver Community to

Jira Service Management through ODBC.

Connect to Jira Service Management

To connect to the Jira Service Management database from DBeaver Enterprise:

1. Select Database > New Database Connection.

2. Select the ODBC driver and click Next.
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) Connect to a database O x
Select your database
Create new database connection. Find your database driver in the list below.
Type part of database/driver name to filter & | Sortby: (O Title @ Score
|
E A T T |
_/ 4 - : =
S Porien MariaDB MySQL
Em saL )
Db2 for LUW MariaDB MongoDB MySOL
N NoSOL
£ Analytical
[N Timeseries S— 4 b
N Embedded ORACLE op-o oL ¢
4 h SOL Server
= Oracle Postgres0L Redshift Snowflake SOL Server

Test Connection ... < Back Finish Cancel

3. In the Database Source field, specify the name of your DSN.
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@) Connect to a database O *
ODBC Connection Settings 0 D
ODEC connecticn settings BC
Main | Driver pruperties| 55H| = Metwork configurations...
Connection
Type: @ Data Source () Manual
Data Source: ‘ DEEAVER_DATASOURCE |

(i) Open ODBC Administrator tool

Authentication

Authentication: Database Mative -

Lzername:

Password: B Save password @
(E} Connection variables information Connection details (name, type, ... )
Driver name: ODBC Driver Settings

Test Connection ... < Back MNext = Cancel

4. Optional: Select Test Connection to verify the connection settings.

E Connection test O X

@ Connected (6527 ma)

Serven N

Driverr DBeaver JDBC-ODBC Bridge (DevartODBC" o «.dlf)
1.0.71 (03.04.0200)

Details ==

5. Click Finish.
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The database appears on the left pane.

6. To view the data stored in a table, expand the database structure and click the needed

table.
(@) DBeaver Enterprise 24.3.0 - Account = a X
File Edit Mavigate S5earch 50l Editor Database Window Help
ﬁ'| ¢ [Jsa ~ T~ @ Auto |£ - [JDBEAVERDATASOURCE ~ E<N/A> ~ @ ~E = & - Q ~
Q iEll@
f® Database Navigator X [ Projects = O B Account X [FB AccountChangeEvent = 0
= ¢ [ properties | I} Data| i ER Diagram [ DBEAVER DATASOURCE [ Tables v [ Account
Enter a part of object name here h

KA - - -
« [ DBEAVER_DATASOURCE £R Account |23 PirjAa- Y
v [ Tables I = @ | Az | Az BillingStreet - ‘ a2 BillingCity + ‘ a2 BillingState . [ value x| =
» FH AcceptedEventRelation % : w-B Eﬂ 2
> B8 Account
2 312 Constitution PlaceTAustin, TX 78767TUS/ Austin TX UK

» FH AccountChangeEvent ¥
5 M9 AccountCleaninfo e 3 888 N Euclié THallis Center, Room 501TTucse Tuc.son A7
» [ AccountContactRole [T‘;' 4 2 Place Jussieu Paris
5> F AccountContactRoleChangeEvent £ 3 The Landmark @ One Market San Francisco CA
5 F AccountFeed é 6 2334 M. Michigan Avenue, Suite 15300TChicac Chicago IL
» 2 AccountHistory 27 9 Tagore LaneTlSingapore, Singapore 7874721 Singapore Singapore
» A AccountPartner 2 345 Shoreline ParkTMountain View, CA 8404 Mountain View CA
» (A AccountShare 9 1301 Avenue of the Americas TMNew York, NY Mew York NY
5 FH ActionLinkGroupTemplate 10 1301 Hoch Drive Lawrence KS
» E ActionLinkTemplate 1 525 5. Lexington Ave Burlington NC
> 3 ActiveFeaturelicenseMetric 12 620 SW Sth Avenue Suite 400TPortland, Oreg Portland OR

. . . -
> 3 ActivePermSetLicenseMetric s I8 Kings Park, 17th Avenue, Team Valley Tradin [
» [ ActiveProfileMetric _15
> FH ActivityFieldHistory £ —
> FH ActivityHistory
» F2 AdditionalMumber @ Refresh + ° - Wil € > : 1 Exportdata v 4%
s P Address 5

200 RARER - 13 row(s) fetched - 0.209s (0.057s fetch), on 2025-02-20 at 20:3%:07
EET | en

Query Jira Service Management data
1. Select SQL Editor > New SQL script.

4

M@ ([ @ 58 |seuedid
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() DBeaver Enterprise 24.3.0 - Solution - O X
File Edit MNavigate Search SOLEditor Database Window Help
¢ ‘ 9 # % | Osc O OpensaLscript ER
- . i
: m DBEAVER DATASOURCE 15 Last edited SQL script Q M | @
T New SQL script Ctrl+]
& Database Navigator = Open 5L console = 0
Enter a part of object name here — B
> [0 SlaProcess Layout > DATASQURCE [ Tables = [T Solution
v E5 Solution Select active schema erresh |[v| BT v dm~ =~
> v Celumns o o ) '
> [ Keys £+ connection Trom navigator v | az Solutionh ¥ | Az Solutionh v | e |
> I Foreign Keys Auto-sync connection with navigater 00000010 GenWatt Install = &
[
>l I:;exes To e 5 00000001 GC1020 Portabl | &
> ferences = s | VIV I LELW Ll 00000002 Generator asser 29
» B SolutionFeed = ®
» FH SelutionHistory - T e
R h = : Save w [®] Cancel : = =3 = —
» BB SolutionStatus | E @ Refres O b Can ISy 24 CH S =
> EB SPSemiAttributes o i< < > Ol M it bpordaa vigk 20 X 10 i
» 8 Stamp 9 -
) 10 row(s) fetched - 0.264s (0.016s fetch), on 2025-02-24 at 16:40:38 =
- I I
2. Enter your query.
(@) DBeaver Enterprise 24,3.0 - <DBEAVER_DATASOURCE> Script = a X

File Edit Mavigate Search 50L Editor Database Window Help
¢ v| % & N | [Tsat =:i[} Commit [ Rollback T~ & Auto o EDBEAVER_DATASOURCE - <NA> v~~~ ~iQ ~
Q i®|l@®

= Database Navigator ¢ [ Projects = B [ Account A AccountChangeEvent Q *<DBEAVER_DATASOURCE> Script ¢ =
§

= & ] SELECT SolutionName, SolutionNote FROM Snlutinn,‘|

1Y) Iy (G sepung === | oupy [T O

Enter a part of object name here N
w DBEAVER_DATASOURCE
v [ Tables I
> FH AcceptedEventRelation
» A Account
» B2 AccountChangeEvent
» 2 AccountCleaninfo
5 A AccountContactRole
» 2 AccountContactRoleChangeEvent
» FA AccountFeed
» FH AccountHistory
» B8 AccountPartner
» B8 AccountShare
> F2 ActionLinkGroupTemplate
» F2 ActionLinkTemplate
» B8 ActiveFeaturelicenseMetric n
» A ActivePermSetLicenseMetric
» A ActiveProfileMetric B
> BB ActivityFieldHistory
> FH ActivityHistory )
5 [ AdditionalMumber [
o= v
5 P Address 0= < . 0‘)

| EI:T| en | Writable | Smart Insert 1:49:48 Sel

M@ lmE >

3. Select SQL Editor > Execute SQL query.

The query results are displayed in the main window.
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@ DBeaver Enterprise 24.3.0 - <DBEAVER_DATASOURCE> Script = a x
Eile Edit Mavigate Search 50LEditor Database Window Help
L3 v| & W | [Jsa ~ T v @i Auto |4D v [FIDBEAVERDATASOURCE ~ El<N/A> v @~ @l v & v Q ~
Q B|@
f® Database Mavig.. » [ Projects = B FH Account 8 AccountChangeEvent [, *<DBEAVER_DATASOURCE= Script % = 8
= & | 3 SELECT SolutionName, SolutionNote FROM Solution; D
Enter a part of object name here T~ =
=
~ [ DBEAVER_DATASOURCE =
v [ Tables | B solution1
> FH AcceptedEventRelation T SELECT SolutionName, Solt | 5 2 P lw| B T v =~
» [ Account ——
5 F9 AccountChangeEvent E = | a7 SelutionName | a7 SelutionNote ¥ | T Value X = g
> 8 AccountCleaninfo M O | GenWatt Corporation has a full-service suppc | U= 0 ":,_?
> 8 AccountContactRole o 2 GC1020 Portable Generator Switch Malfunctior If the generator switch is not working, remowe Geniatt Instal =
> F3 AccountContactRoleChangeEvent 273 Generator assembly instructions unclear The Maintenance Manuals for the GC1020 are =
> B Ac(ountFe.ed [?;' 4 Maintenance guidelines for generator unclear  The Maintenance Manuals for the GC1060 are ®
> B icmuntslstor)r + 5§ Selecting the Right Generator for Your MNeeds  GenWatt offers a wide range of electric gener i
’ g Accounts:rtner é 6 GC3000 Series Propane Generator Ignition The GC3000 series propane generators need t i
? c(.nun. are 27 Starting generator after electrical failure After an electical failure, the generator has to i)
» B3 ActionLinkGroupTemplate . L . ™ + =]
Lo 8 Electrical wiring installation for GC5060 The red wiring from the top electronic panel ¢ =
» FE ActionLinkTemplate = . . ; d
5 FF ActiveFeatureLicenseMetric s 9 Electronic panel fitting loose On the GC3020, the electronic panel is known
5 O ActivePermSetLicenseMetric 3:: 10 GenWatt SLA Commitments GenWatt offers four different SLAs with differ
» B8 ActiveProfileMetric il [—
» FH ActivityFieldHistory @ Ref 3 ] :
resh - : - T R T, Exportdata ~ :
> B Ackhiybitory B . W= > 2  Bxp X
200 x 10 : =10 row(s) fetched - 0.35%s, on 2025-02-20 at 20:46:03 l‘_\
EET | en | Writable Smart Insert 1:45:48 Sel

4.2 Using in DBxtra

Troubleshooting Jira Service Management ODBC
Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to Jira Service Management
in DBxtra.

Due to incompatibilities between DBxtra and Jira Service Management, leaving the sqL
dialect property to its default might present various issues. To resolve compatibility issues,
set the property to Ms Access 2000/xP/2003 Or ANSI sqQL/2ee3 for DBxtra version 11.0.1 or
newer, and to ANsI sqL/2ee3 for versions prior to 11.0.1.
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Connect through ODBC E3

NOTE:

Imiportant!

Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.

Please be sure to select the right SQL dialect for your connection.

Connection name |MyData

Data source |DataSource 1 III

User

Password

1

Connection timeout | 15| 5| sqL dislect| | MS Access 2000/... |w |

Enable Offline Mode

Get columns descriptions
Select User Groups who can view this Connection

[#]accounting n
[]contraling

Guest Group

[~ILegal

Management

[#IManufacturing

[#Marketing

[Purchasing W

Select Al Unselect Al Cancel

4.3 Using in Informatica PowerCenter

You can connect Informatica PowerCenter to Jira Service Management through an ODBC
driver on Windows to unify and manage data across these systems.

Prerequisites

e Configure the Informatica services.
¢ |nstall the PowerCenter Client tools.

e Create a repository folder in PowerCenter Repository Manager.
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e |nstall Devart ODBC Driver for Jira Service Management. For instructions, see Installation.

e Configure a data source name (DSN). For instructions, see Windows DSN Configuration.

Add a data source in Informatica PowerCenter

Before you proceed, make sure PowerCenter Designer isn't running.

1.Open-the.c:\Informatica\10.4.1\clients\PowerCenterClient\client\bin\powrmart.ini-file

in a text editor.

2. In the [obBcDLL] section, add Jira Service Management=EXTODBC.DLL, then save the

changes.
3. Open PowerCenter Designer.
4. Double-click the repository name (in this example, PCRS), enter your Informatica

credentials, then click Connect.

G) nformatica PowerCenter Designer - [Start Page] — m} x®
0 Repository Edit View Tools Versioning Windows Help - 0 X
o] | Sl =l | & IR 100% | | = |
Cooo | P 'y @ 9
x|
&= Repositories
e B [PCRS
Getting Started Resource Center
MNew Features and Enhancements Informatica.com
Product Qverview Informatica Network
Connect to Repository X
Connect to Repository
Repository: PCRS TR
Username: | USERMNAME ‘ Help
[=]
Password: | el ‘ Egg Incements
= Mare > " "
Connect g predictive analytics,
Security Domain: Mative = E, and integrated health
domains.
Sign Up now to start using Operational Insights.
Copyright & 1993-2020 Informatica LLC. All Rights Reserved.
x|
o]
I1| 4 | }l Hl\ Save AFetch Log )\Generate )\Validate )\ Debugger )\Session Log )\ Notifications / ‘l £ >
Ready I 1

5. Double-click the repository folder (in this example, ODBC connections), then select
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Sources > Import from Database.

G) Infermatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]]

@Reposltory Edit View Tools Layout Versiening Sources Window Help

[# ODBC connections - [PCRS)

v |- Import from Database... R‘

\= Import from Eile...

QDO | LB

==
& Repositories @i
B & PCRS S0l

=P

Business Components
Sources

Targets

Cubes

Dimensions
Transformations
Mapplets

Mappings
User-Defined Functions

TTITVTTIS

Lbx

Import frem Cobel File..
Import XML Definition...

Import From PeopleSoft ...

Web Service Provider

Import from PowerExchange...

Import From Salesforce

Import From AmazenRSCloudAdapter
Import From AmazenS3Plugin

Import from Informatica Cloud...

Create PowerExchange for BigQuery Source..,

Create PowerExchange For Snowflake Source...

Create PowerExchange for Microsoft Dynamics 365 for Sales Source..
Create PowerExchange for Goegle Cloud Spanner Source...
Create PowerExchange for Goegle Analytics Source...
Create AzureDWv3 Source...

Create PowerExchange for Google Cloud Storage Source..,
Create PowerExchange For PostgreSOL Source..,

Create PowerExchange for Kafka Source...

Create MongoDB Source...

Create 5APTableReader Source...

= Create...

IA_L§1 Compare...

89

Import frem a given database

| ‘ | [\Save AFetch Log )\Generate ,\Validate }\Debugger l,\Se:isiorl Log f\ Notifications /

The Import Tables dialog opens.

6. From the ODBC data source menu, select the needed DSN.

m} x
- 8 X
-~
v
>
|« >
NUM

7. In the Username and Password fields, enter your Jira Service Management credentials.

8. Under Show owners, select All.

9. Click Connect.
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Import Tables >

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ ...

|Jse Kerberos Authentication Cancel
Username: | USERNAME | Help
Owner name: <ALL=
PESSWDrd: | ------------| |
Select tables

Show owners:

Default

Search for tables named:

I:I Search

Select all

Select naone

10.In the Select tables section, expand the tree and select the tables you want to import.

11.Click OK.
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Import Tables >

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ |...

Cancel
|Jse Kerberos Authentication
Help
Username: | USERNAME | Z
Owrer name: <ALL > ==
Easswurd: | (121221173 7%] | F'.E—t_:ﬂr‘lﬂECt
Select tables
=-0 -iBLES * | Show owners:
----- 1] AcceptedEventRelation
----- Biiil Account — =z
""" EEE AccountContactRelation Search for tables named:
----- I AccountContactRole emch
----- fif] AccountFeed I:I
g1 Accounttistory |
----- gia) AccountPartner
----- if] AccountShare
----- [ ActionLinkGroupTemplate Select al
----- [{f] ActionLinkTemplate W
< 3 Select none

The table schemas appear in the Source Analyzer, and the data source is added to the
Sources subfolder of the repository folder. You can now create mappings and work with Jira

Service Management data in Informatica PowerCenter.
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0 Informatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] - ] *
5’:’) Repository Edit  View Tools Layout Versioning Sources Window Help - & x
[ ODBC connections - [PCRS-LIN] ~ | @ .)“15 100% ~ £ @ '5; 'QD ':»éa
QDO | L5
==
. 2y B B g
& Repositories
T8 ecs CEEmewEGT T -
=] @ ODBC connections K Name Datatype ™
i [ Business Components 9 Id nvarchar
B Seurces IsDeleted bit
B [PRE-CONFIGURED DSN Masterfecord k[ SRR eeaNODEC) M -]
B Targets Name K Name Datatype ™
) Cubes Type
. #ud nvarchar
) Dimensions <
. Parentld nvarchar
[ Transformations S
Type - Jfcatnteistory (ODBC)  [11[=]
) Mapplets e dByld =
' reatedBy K Name Datatype
[} Mappings CreatedDate
w [ User-Defined Functions @ nvarchar
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4.4 Using in Microsoft Access

Connecting Microsoft Access to Jira Service
Management Using an ODBC Driver

This article explains how to connect Microsoft Access to Jira Service Management through
the standard ODBC interface. Microsoft Access is a dababase management system that
combines the relational database engine with a graphical user interface. Access can be used
as a substitution for spreadsheet applications like Excel to organize, store, and retrieve large
amounts of related data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Jira Service Management data either by
importing it or creating a table that links to the data. Devart ODBC drivers support all modern
versions of Access. It is assumed that you have already installed and configured a DSN for
ODBC driver for Jira Service Management. For the purpose of this article, we tested an
ODBC connection to Jira Service Management through our ODBC drivers in Microsoft
Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft Access 2013,
Microsoft Access 2016, Microsoft Access 2019. The following steps describe how to use
Microsoft Access 2019 to import or link to your data in Jira Service Management.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/jiraservice/

Using in Third-Party Tools 93

Importing Jira Service Management Data Into Microsoft Access
Through an ODBC Connection

1. Open your Microsoft Access database.
2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Jira Service Management and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps
checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Jira Service Management Data in Microsoft Access Through
an ODBC Connection

1. Open your Microsoft Access database.
2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.
6. Select the DSN that you have configured for Jira Service Management and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.
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8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Jira Service Management table as the unique record
identifier. You are linking multiple tables, you will be prompted to select unique record
identifiers for each of the selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

4.5 Using in Microsoft Excel

Connecting to Jira Service Management from Microsoft
Excel using ODBC Driver for Jira Service Management

You can use Microsoft Excel to access data from a Jira Service Management database using
ODBC connector. With ODBC Driver, you can import the data directly into an Excel
Spreadsheet and present it as a table. Make sure that you use matching Excel and ODBC
Driver, e.g. if you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version
of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Jira Service Management with Get & Transform (Power Query)

e Connecting Excel to Jira Service Management with Data Connection Wizard (Legacy

Wizard)

e Connecting Excel to Jira Service Management with the Query Wizard

e Connecting Excel to Jira Service Management with Microsoft Query

e Connecting Excel to Jira Service Management with PowerPivot

Connecting Excel to Jira Service Management with Get
& Transform (Power Query)

You can use Get & Transform (Power Query) to connect to Jira Service Management from
Excel with ODBC. This method assumes that you've installed an ODBC driver for Jira
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Service Management.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other
Sources > From ODBC.

=] Bookl - Excel Evgeniy Lemeshov |
File Home Insert Page Layout Formulas Review View Help @ Tellme S Share
& [ Ta B a7 Y N E B s B e
=1 K - .
Get Refresh z] Sort Filter Textto _, & What-If Forecast Outline
Data - B All - Y columns = 7 & Analysis = Sheet M
Gi Sort & Filter Data Toals Farecast 5
ﬁ From File L
o L
From Database » - - - - =
— 1 3
R 0 - | + 100%
= = From Azure * From Table/Range
B
_g From Online Services 4 _@ From Web
'y
¢. From Qther Sources 4 From Microsoft Query
B
‘_)r"j Combine Queries k _¢. From QDBC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the
credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.
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From ODBC

Data source name (DSN)

Devart ODBC Dniver b

4 Advanced options

Connection string (non-credential properties) (optional) G

501 statement [optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (opticnal)

(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.

ODBC driver
Default or Custom @ dsn=Devart ODBC Driver
. Use a username and password to access a data source with an QDBC driver,

Windows

User name
Database myusemame

Password

FEERRBERDEE

Credential connection string properties (optional) (O

Back Cancel
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If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom '¢' dS'_' =Devart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (D)

Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

O
Navigator
yo

Select multiple items
Display Options = [‘%
4 E' ODBC (dsn=0DBC Driver far 5... A

EH AcceptedEventRelation . .

F No item selected for preview

B Account

B} AccountChangeEvent

B AccountCleaninfo

B AccountContactRole

B AccountContactRoleChange...
Select Related Tables load |~ Edit Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.
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C
C

onnecting Excel to Jira Service Management with Data
onnection Wizard (Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has

alr
1.

6.

eady been defined.
In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.

. In the opened dialog, select ODBC DSN and click Next to continue.
. Now select a data source you want to connect to, and click Next.

. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Jira Service Management with the
Query Wizard
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You can use this option to create a simple query for retrieving data from Jira Service
Management to Excel via ODBC driver.

1.
2.
3.

0 N O O

Open Excel, in the main menu, click the Data tab.
Click the From Other Sources dropdown menu, and then click From Microsoft Query.

In the appeared dialog, you can choose the data source you want to connect to.

. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.
. Select Return Data To Microsoft Excel and click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

. The required data is successfully imported to Excel.

Connecting Excel to Jira Service Management with
Microsoft Query

You can use this option to create a more complex query for retrieving Jira Service
Management data to Excel via ODBC driver.

1.
2.
3.

Start Excel, click the Data tab.
In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Jira Service Management). Uncheck Use the Query Wizard to
Create/Edit Queries and click OK.

. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Jira Service Management with
PowerPivot
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4.6

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data
models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Jira Service Management), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

Using in Microsoft Visual Studio

Importing Jira Service Management Data into Visual
Studio Through an ODBC Connection

A Visual Studio is a powerful tool containing features that allow editing, debugging, and
compilating the code and creating applications that can be connected to any databases
product and services on a local machine and network, and any type of cloud (private, public,
or hybrid). To connect Visual Studio to a data source such as Jira Service Management, you
can use an appropriate ODBC driver.

This guide describes how to connect to Jira Service Management and retrieve data importing
them to Visual Studio with an ODBC driver. It is assumed that you have already installed and
configured a DSN for ODBC driver for Jira Service Management.

1. Run Visual Studio Desktop and click Tool and select Connect to Database.

2. In the Add connection dialog box, select the Microsoft ODBC Data Source as a data
source.

3. In the Data source specification point expand the Data Source Name (DSN) drop-down
list and select the previously configured DSN for Jira Service Management. Alternatively,

you can connect to the database by entering the DSN in a Use connection string field. To

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools| 101

check whether your connection is successful, click Test connection. Click OK.

4. If your data source is password-protected, Visual Studio will prompt you for user

credentials. Type your Username and Password in the respective fields and click OK.

5. In the Server Explorer you can see the database structure. Choose Tables, right-click the
table you want to view the data of and select Retrieve Data. You can also preview the

contents of the database objects by clicking on them.

4.7 Using in OpenOffice and LibreOffice

Connecting to Jira Service Management from
OpenOffice and LibreOffice using ODBC Driver for Jira
Service Management

The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Jira Service Management data from
Open Office Base or LibreOffice Base — desktop database management systems. Note that
the Windows version of OpenOffice is 32-bit, and you may get the error “The specified DSN
contains an architecture mismatch between the Driver and Application” when trying to access
a data source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-
bit version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for Jira
Service Management, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.
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Apache . ™
€3 OpenOffice™ 4

; ; = .
‘E Text Document; E Drawing

@ Spreadsheet @ Database
Presentation E Formula
@ Open... bt |_r/_| Templates...

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools| 103

iZ| Untitled 1 - O penOffice Writer
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Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard *
Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,

2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

ODEC w

Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for Jira Service Management, or

you can click Browse, double-click the data source you need, and then click Next.

Database Wizard x
Steps Set up a connection to an ODBC database
1. Select database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

Set up ODBC connection

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Jira Service Management and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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Mew Databasel16.odb - OpenOffice Base = O X
File Edit View Insert Tools Window Help x
‘B-@- T H=RC R i

[A Use Wizard to Create Table..

Create Table in Design View... ‘ Description

=
ER
Queres
AcceptedEventRelation ~ None =
= Account
Forms AccountChangeEvent

AccountCleaninfo

AccountContactRole

Reports AccountContactRoleChangeEvent

£ solution - New Database162 - CpenOffice Base: Table Data View = O x
File Edit View |nsert Tools Window Help

P2 K B B 2NN K v

||

SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote | O

I |GC1020 Portable Generator Switch Malfunctioning ] O Reviewed ] If the generator 005!
Generator assembly instructions unclear O O Draft O The 005
___|Maintenance guidelines for generator unclear O O Draft O The 005!
__|5electing the Right Generatar for Your Needs ] O Reviewed ] GenWatt offers 005!
__ |GC3000 Series Propane Generator Ignition | O Reviewed | The GC3000 005
___|starting generator after electrical failure O O Draft O After an 005!
___|Electrical wiring installation for GC5060 O O Draft O The red wiring  005:
GenWatt SLA Commitments 1 O Reviewed | GenWatt offers 005!
Electronic panel fitting loose O O Draft O On the GC3020, 005!
GenWatt Installation Services [ | Reviewed %] GenWatt 005:

7. To create an SQL query, click Queries in the Database pane, then click Create Query in
SQL View...
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MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B3 - E-@y ]
[ Create Query in Design View... Description
\E= (& Use wizard to Create Query Create a query entering an SQL statement dirs

Tables |§&|. Create Query in SQL View... |
F
EEE

i

ﬁ

Farms

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Databasel6.0db : Query1 - OpenOffice Base: Query Design — O X

File Edit Miew [nsert Tools Window Help

B Rm® D i |
B WS- NIRRT VIFY
SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote
_b |GC1020 Portable Generator Switch Malfunctioning O Reviewed If the generator |0
Generator assembly instructions unclear | O Draft | The 0
___ |Maintenance guidelines for generator unclear l O Draft [l The ]
___|5electing the Right Generator for Your Needs O Reviewed GenWatt offers |0
__|GC3000 Series Propane Generator Ignition O Reviewed The GC3000 o
___|starting generator after electrical failure l O Draft [l After an ]
___|Electrical wiring installation for GC5060 [l O Drraft [l The red wiring 0
Watt SLA Commitments M M Reviewed M GenWatt offers |0
Recor?ﬂ [ of 10 W mle] < >

SELECT * FECM Solution;

4.8 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
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remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for Jira Service Management, create an

initialization file for your Oracle Database Gateway for ODBC. The sample file
initdg4odbc.ora is stored in the oRACLE_HOME\hs\admin directory. To create an initialization file
for the gateway, copy the sample initialization file and rename it. The name must be prefixed
with init — for example, initJira Service Management.ora. YOUu need a separate initialization
file for each ODBC data source. After creating the file, set the HS_FDS_CONNECT_INFO parameter
to the system DSN that you created earlier, for example:

HS_FDS_CONNECT_INFO=Jira Service Management

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orRACLE_HOME\NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = localhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_NamE) must be the same in 1istener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=

(SID_LIST=

(SID_DESC=
(SID_NAME=]ira Service Management)
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(ORACLE_HOME=D: \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the

listener.ora file.

Jira Service Management =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = Tlocalhost) (PORT = 1521))
(CONNECT_DATA =
5 (SID = Jira Service Management)

(HS = 0K)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK Statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also
Configuring Oracle Database Gateway for ODBC

49 Usingin PHP

Connecting to Jira Service Management from PHP using
ODBC Driver for Jira Service Management

PHP is one of the most popular programming languages for website development. ODBC
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drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Jira Service Management via ODBC. The script
connects to Jira Service Management database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for ODBC Driv

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

$result = odbc_result_all($RecordSet, "border=1");

odbc_close($0DBCConnection);
7>
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You can modify this script by specifying general settings for each Devart ODBC driver to use
any of them with your PHP projects.

Using in Power Bl

Importing Jira Service Management Data into Power Bl
Through an ODBC Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Jira Service Management, you can
use a corresponding ODBC driver.

This tutorial explores how to connect to Jira Service Management and import data into Power
Bl Desktop using an ODBC driver. It is assumed that you have already installed and
configured a DSN for ODBC driver for Jira Service Management.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Jira Service Management

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the Jira Service Management data into Power Bl for analysis, select the needed

table and click Load.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

116

ODBC Driver for Jira Service Management

411

Using in Python

Installing the ODBC Diriver for Jira Service Management

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Jira Service Management. To use the

ODBC driver as a translation layer between the application and the database, you need to
configure it by following the installation instructions.

Connecting to Jira Service Management from Python
using ODBC Driver for Jira Service Management

Here’s an example to show you how to connect to Jira Service Management via Devart

ODBC Driver in Python. First we import the pyodbc module, then create a connection to the
database, insert a new row and read the contents of the EMP table while printing each row to
the Python interactive console. To execute the script, you can type the code directly in the
interactive console or add the code to a file with the .py extension and run the file from the
command prompt.

Step 1: Connect

import pyodbc _ _ _
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Jira Service Managemen

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The
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cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.
cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
print (row)
row = cursor.fetchone()

cursor.close()
cnxn.close()

412 Using in QlikView

Connecting to Jira Service Management from QlikView
using ODBC Driver for Jira Service Management

This tutorial describes how to connect and configure QlikView to retrieve data from Jira
Service Management for further analysis. QlikView is a data visualization tool that connects
and pulls data from different popular databases like MySQL, MongoDB, Oracle, SQL Server,
Postgres, etc. to present it in a single view. The business intelligence platform identifies
relationships in your data and discovers patterns and opportunities to support your decision
making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or
later.

To connect to an ODBC data source from QlikView using our driver for Jira Service
Management, perform the steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{ File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

i | New ctri+N || B | | v | (2| @) 52 B K clear | @ Back @ Forward | & Lock & Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites 4
=l | save Ctrl+5
Save As.. F12

Save Link

Mail as Attachment...

are. as a LInk

viall WITN boOokK a5 a
Print Sheet...
Source Control »
Export 4
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.

@ Edit Script [CA\Users\EvgeniyL\Documentsynew.qvw®] - O *
File Edit Insert Tab Tools Help
Z}Reload B Debug | = S| 4 2 @] O [0 <1 2 Tabs Main v =8 =
k ain
ODBC CONNECT TO [ODBC Driver forMarketo 1; L
SELECT * FROM Scluticn;
W
Data  Functions “ariables  Settings
[atabaze [ata from Files
| ODBC v| | Connect.. [ Rielative Paths Table Files...
JuseFTP it E
[ Farce 32 Bit Select... Q= L=
“Weh Files...
Field Data...
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Sheet Properties [Main]

General Fields

Ohjects

Securty  Triggers

Available Fields
i CreatedByld

CreatedDate

Id

lzDeleted

lsHtml

lzPublighed
lzPublishedInPublickb
lsReviewed
LastModifiedByld
LastModifiedDate
LastReferencedDate
LastViewedDate

Add =

Add All ==

< Remove

Fields Displayed in Listboxes

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.

@ QlikView x64 Personal Edition - [CUsers\ ODBC\Documentsh 1.gvw™]
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413

4131

@ qlikview x64 Personal Edition - [C\Users\EvgeniyL\Documents\new.guw®] = O x
! File Edit View Selections Layout Settings Bookmarks Reports Tools Object  Window  Help -8 X
INE S EH S EE D & O S ] -&|9)L®?§mclear‘|@83ck 3 Forward | (8 Lock J"Unlock
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SolutionName SolutionMNote

Electrical wiring installation for GC5060 The red wiring from the top electronic panel of the GCS080 and the vellow wiring on the main generator assemby have to be connected
Electronic panel fitting loose On the GC3020, the electronic panel is known to disengage from the main generator body especially when used at the higher-end of th
GC1020 Portable Generator Switch Malfunctioning  If the generator switch is not working, remove the switch and re-assemble it. Often the switch gets displaced by a fraction of an inch pr
GC3000 Series Propane Generator Ignition The GC3000 series propane generators need to be started up using the following process if the ignition fails at the first try:

Generator assembly instructions unclear The Maintenance Manuals for the GC1020 ara currenthy in reveiw and will be shorthy updated and distributed to all customers. We have
Gen\Watt Installation Services Gen\Watt Corporation has a full-service support organization offering customers every type of installation assistance - from complete st
Gen\Watt SLA Commitments Gen\Watt offers four different SLAs with different service commitments as follows:

Maintenance guidelines for generator unclear The Maintenance Manuals for the GC1060 are currenthy in reveiw and will be shorthy updated and distributed to all customers. We have
Salecting the Right Generator for Your Needs Gen\Watt offers @ wide range of electric generators for every need -- from high-powered industrial-strength generators, to medium-capz
Starting generator after elactrical failure After an electical failure, the generator has to be manually turned off before establishing the connection again. If the generator is tumne

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Jira Service
Management from SQL Server Management Studio using ODBC Driver for Jira Service
Management.

e Creating a Linked Server

e Troubleshooting in SSMS

Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN.

¢ The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.
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e ODBC Diriver for Jira Service Management and SQL Server must be installed on the same

computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Jira Service Management from SQL
Server Management Studio using ODBC Diriver for Jira
Service Management

You can use the Microsoft SQL Server Management Studio to connect your Jira Service
Management data to an SQL Server instance. Linked Server is a tool of MS SQL Server that
allows to execute distributed queries to refer tables stored on non-SQL Server datbase in a
single query. With linked servers, you can execute commands against different data sources
such as Jira Service Management and merge them with your SQL Server database. You can
create a linked server with one of these methods: by using the options in the Object Explorer
or by executing stored procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Jira Service
Management:

1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Jira Service Management

You can follow the steps to create a linked server for Jira Service Management in SQL Server
Management Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.

e Under Server type, select Other data source .
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e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down

list.

¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for Jira

Service Management. Alternatively, you can input the ODBC Driver connection string in

the Provider field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Jira Service Management databases through SQL

Server.

Retrieving Data From Jira Service Management

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on

it

Object Explorer = 0 x

Connect~ ¥ *¥ (VI

= a EVGEMIYL\SQLEXPRESS (5QL Server 1401000 -
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
=] Providers
@8 ADsDSOObject
@8 MSDAOSP
w8 MSDASQOL
wE MSOLAP
wh MSOLEDBSQL
@b Search.CollatorDsSO

In the appeared Provider Options window, enable the Allow inprocess checkbox:
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@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers - O x
Selecta page IT Script ~ &) Help
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Create a new Linked Server

Object Explorer * I x
Connect~ ¥ ¥ ¢ o+
= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
:
Providers |_ Mew Linked Server...
Triggers

Start Powershell

Replication
PolyBase Reports '
Management Refresh

HEvent Profiler

3]

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:
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H New Linked Server = O *
Selecta page HSGI‘iDtVﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. JJIRASERVICE. In the Product Name and
Data Source fields you need to indicate the System DSN that you've previously created -
more info on System DSN setup can be found here.

*3 Mew Linked Serve — O
Select a page IT Scipt ~ a Help
& General
& Securty
& Server Options Linked server: JIRA SERVICE MANAGEMENT
Servertype:
() SQL Server

© Other data source

Provider: Microsoft OLE DB Provider for ODBC Drivers e
Product name: Devart ODBC Driver for Jira Service Management

Data source:

Pravider string:

Catalog

Connechion

The Jira Service Management tables are already available to be fetched. To query the linked
server, click New Query in the toolbar:
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File Edit View Project SQOL Complete Tools  Windoy
i @-0|B®-1-a ¥ | B New Query B & &
3 | | b Execute

|
Object Explorer = 0 x

Connect~ ¥ *¥ (VIS

=] E EVGEMIYLASQOLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
.
Providers
H ORACLE
B POSTGRESGL
B sauTe

B EHEBH

Enter your SQL query in the editor window and click Execute to run the query:

142 5QLQueryS.sql - VFGBHMITGLmaster (VFGBHMITGI\test (51))* - Microsoft SQL Server M: Studic (Admini
File Edit View Query Project Debug Tools Window Help
Pl il D | NewQuey (e iR G| 4 a9 - -8-5 ] b |
PZ b [[mester ]| ¥ Bewte D Debug ® v 33 5l | 370 |§A4T = 2 | (85 o) o & | ChangeType~ | ¥ by
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= Result: 3
5 1] defautt & Resuts |y
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= Articles
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= Info
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As a result, you can see the contents of the selected table retrieved directly from the Jira
Service Management account you are connected to.

See also
¢ Troubleshooting SSMS
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4.13.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:

-
. Component Services

I

. File Action View Window Help
= | #EXECEHE D IE:=

DE°”5°|ER°°t Windo...  Windows... Windows R... Windows R... * | Actions
4 #. Component Services

. DCOM Config -
a4 || Computers ﬁr ﬁ ﬁ ﬁ
More Actions »

4 (& My Computer . ) . )
i Microsoft Microsoft Microsoft Microsoft
Windo...  Windows.. WMIPro.. WMIProvi.

5] COM+ Applicatig
> (| DCOM Cenfig

[ [] Running Processe ﬁ. ﬁ ﬁ ﬁ
[ || Distributed Transi
B @ Event Viewer (Local) Microsoft... Microsoft.L.. MicrosoftV... Microsoft....
AppID
MMC ANy MSMDPP - MsRdp5ess...
Applicati... LIZE

MSTTS Mahimicse.. MAP Agent Map Elevated

I+ £ Services (Local)

m

DecObj Cla... Service COM class
NCLUA MDFAPT netman netprofm

g & & @&

MetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

< 1 3 -
i
||

s S

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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F B
MSDAINITIALIZE Properties L2 ||

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D 1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

Change ownerta:

Name

= 4 Administrators {

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

.
| Permissions for (2206CDB0-10C1-11D1-89E0-00COAF... ()

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

ok ] [Cance 7] [ oy

After this you should be able to edit MSDAINITIALIZE security settings.

See also

e Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"

414 Usingin SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Jira Service

Management as a translation layer between the data source and SSIS, the driver and SSIS
communicate via Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
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an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the
Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.

General Advanced settings  License About

Meta Data
Connection
—
-
Compatibility
ODBC Behavior [ Ver 2.x o
String Types Default &

IUse Local Regional Settings when converting to string

[ Imumbers [ ]Dates and times

Test Connection - Cancel

415 Usingin Tableau

Importing Jira Service Management Data Into Tableau
Through an ODBC Connection

This article explains to establish and ODBC connection to Jira Service Management from
Tableau Desktop. Tableau is a data visualization tool that allows you to pull in raw data,
perform analysis on it, and create meaningful reports to get actionable insights. With Tableau
Desktop and our suite of ODBC drivers, you can connect to various relational and non-
relational databases, both cloud and on-premise.
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1. Run Tableau Desktop.
. On the start page, select More... in the Connect pane.

. Choose Other Databases (ODBC).

A WN

. Expand the DSN drop-down list and select the DSN that you have created and configured
for Jira Service Management. Alternatively, if you have not created a DSN, you can choose
the Driver option and select Devart ODBC Driver for Jira Service Management from the
drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Jira Service Management.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the

table.

10.Hit Update Now to retrieve and display the data.
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